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Wwise Unity Integration 2017.2.1.6524.980

Wwise 2017.2.1 Wwise SDK

e Wwise SDK2017.2.1

e UnityUnity 5.5, 5.6, 2017.1, 2017.2, 2017.3 (Personal Pro)

Q Unity 4

Wwise Unity Integration

Linux
Mac

PS4

tvOS
Windows
Xbox One

Unity 2017.3.0f3

UWP (Universal
Windows Platform)

Unity 2017.3.0p3

Android
i0OS
|Switch

Unity for Nintendo Switch 3.1.2 (Unity 5.6.4
with NintendoSDK 3.5.2)

WG-34267: Placed the members of Wwise_IDs.cs within the AK
namespace and prefixed class names with "Ak".

WG-35301: Changed Event selector to automatically display in
inspector when AkeventSection is added to Timeline track.
WG-35609: Made AkroomPortal inspector update the front and back

rooms in real time.

WG-36086: Added public functions to AkRoomPortal to update the

front and back rooms.

WG-36099: Fixed NullReferenceException when migrating from

2016.2.4.




WG-36125: Fixed compatibility with Unity 5.5.

WG-36144: Fully specified system.10.pPath in Wwise C# script to
avoid potential conflicts.

WG-36219: Fixed drag and drop from the Wwise Picker under Unity
2017.3.

WG-36356: Exposed monitoring pool size and queue size in
Akinitializer inspector.

WG-36413: Fixed crash when having more than one portal from one
room to the other.



Wwise Unity Integration 2017.2.0.6500.947

Wwise 2017.2.0 Wwise SDK Unity 2017.3

e Wwise SDK: 2017.2.0
e UnityUnity 5.5, 5.6, 2017.1, 2017.2, 2017.3 (Personal Pro)

Q Unity 4

| ||Wwise Unity Integration

Mac

Windows Unity 2017.3.0f3

Android

I0S

Linux

PS4

tvOS

UWP (Universal
Windows Platform)

Unity 2017.2.0f3

Xbox One
Switch Unity for Nintendo Switch 3.1.2 (Unity 5.6.4
NintendoSDK 3.5.2)
. 2017.2
J 2017.2

WG-25994: Made the audio input source plug-in accessible via C#
scripting. Using the Audio Input Source Plug-in in Unity.
WG-27337: Added ability to post MIDI events to the sound engine.



Sending MIDI to Wwise.
e WG-28541 Ak Ak
e WG-33501: Added automatic SoundBank management.
e WG-34446: Reduced memory allocations in AkCallbackManager.



Wwise Unity Integration 2017.1.4.6407.845

e Wwise SDK2017.1.4
e UnityUnity 5.5, 5.6, 2017.1 2017.2 (Personal Pro).

;J Unity 4

| ||Wwise Unity Integration

Android

I0S

Linux

Mac

PS4

PS Vita Unity 2017.2.0f3
tvOS

UWP (Universal

Windows Platform)

Windows

Xbox One

Switch Unity for Nintendo Switch 3.1.2 (Unity 5.6.4
NintendoSDK 3.5.2)

WG-35168: Fixed crash when loading SoundBanks on Switch.
WG-35383: Fixed update of IDs associated with WwiseTypes when
used as properties within custom inspectors.

WG-35384: AkAudioListener, AkInitializer, and AkTerminator NOW
implement onenable () instead of Awake(), SO they are disabled when
unchecked in the Editor.

WG-35513: Added full custom positioning for AkGameObj.
WG-35958: Unity 2017.3 support added. Note the integration has not
been thoroughly tested in Unity 2017.3, but it should be compatible.



Wwise Unity Integration 2017.1.3.6377.812

Wwise 2017.1.3 Wwise SDK Unity 2017.1

e Wwise SDK2017.1.3
e UnityUnity 5.5, 5.6, 2017.1 2017.2 (Personal Pro).

»;J Unity 4

| Wwise Unity Integration

Android
I0S
Linux
Mac
PS4

PS Vita Unity 2017.2.0f3
tvOS

UWP (Universal
Windows Platform)
Windows

Xbox One

: Unity for Switch 1.0.1 (Unity 5.5.0p1
Switch Nintendo SDK 1.4.0)

e WG-34855: Added AkSoundEngine.GetCurrentLanguage().
e WG-35075: Fixed: Added support for Unity 2017.2 integration in the
Wwise Launcher.



Wwise Unity Integration 2017.1.2.6361.791

Wwise 2017.2 Wwise SDK

e Wwise SDK: 2017.1.2

e Unity: Unity 2017.1Personal Pro

Q Unity 4

Wwise Unity Integration

Android

I0S

Linux

Mac

PS4

PS Vita

tvOS

UWP (Universal
Windows Platform)
Windows

Xbox One

Unity 2017.1.1f1

Switch

Unity for Switch 1.0.1 (Unity 5.5.0p1
Nintendo SDK 1.4.0)




Wwise Unity Integration 2017.1.1.6340.770

Wwise 2017.1.1 Wwise SDK Unity 2017.1

e Wwise SDK: 2017.1.1

e Unity: Unity 2017.1Personal Pro

Q Unity 4

Wwise Unity Integration

Mac
Windows

Unity 2017.1.0f3

Android

I0S

Linux

PS4

PS Vita

tvOS

UWP (Universal
Windows Platform)
Xbox One

Unity 5.6.1p1

Switch

Unity for Switch 1.0.1 (Unity 5.5.0p1

Nintendo SDK 1.4.0)

WG-33018: Fixed: No localization folder is created when using the

Decode Banks feature.

WG-33818: Fixed bank decoding on iOS and Android.
WG-34090 WSA Unity Plugin TLS Allocator Error spamming
WG-34205System.EventHandler
WG-34205UnityEditor.Menu UnityEditor.Menultem




Wwise Unity Integration 2017.1.0.6302.726

Wwise 2017.1.0 Wwise SDK Unity 2017.1

e Wwise SDK: 2017.1.0

e Unity: Unity 2017.1Personal Pro

»Q Unity 4

Wwise Unity Integration

Mac
Windows

Unity 2017.1.0f3

Android

I0S

Linux

PS4

PS Vita

tvOS

UWP (Universal
Windows Platform)

Unity 5.6.1p1

Xbox One
: Unity for Switch 1.0.1 (Unity 5.5.0p1
Switch Nintendo SDK 1.4.0)
2017.1
Wii U
GameObject Unity Integration Extensions Wwise

Installation and Migration Guide

AkCallbackManager

2017.1



https://www.audiokinetic.com/library/edge/?source=InstallGuide&id=integrating_wwise_into_an_unreal_or_unity_project

WG-27479 AkInitializer

WG-30791 WwiseTypes WwiseTypes

WG-31155 AkMemSettings AkChannelConfig SoundEngine
WG-31735 GameObjects Unity Integration
Extensions

WG-32348 SoundBanksIinfo XML

WG-32657 foreach

WG-33303 AK_MusicPlaylistSelect

WG-34003



Wwise Unity Integration 2016.2.4.6098.531

Wwise 2016.2.4 Wwise SDK

e Wwise SDK: 2016.2.4
e Unity: Unity 5.6Personal Pro

»;J Unity 4

Wwise Unity Integration

Android
i0OS
Linux
Mac
PS4
PS Vita Unity 5.6.1p1
tvOS

Windows

Windows Store (Universal
Windows Platform)

Xbox One

: Unity for Switch 1.0.1 (Unity 5.5.0p1
Switch NintendoSDK 1.4.0)
Wii U Unity 5.4.2f2

e WG-33395



Wwise Unity Integration 2016.2.3.6077.504

Wwise 2016.2.3 Wwise SDK

e Wwise SDK: 2016.2.3
e Unity: Unity 5.6Personal Pro

Q Unity 4

Wwise Unity Integration

Android
I0S
Linux
Mac
PS4
PS Vita Unity 5.6.0f3
tvOS

Windows

Windows Store (Universal Windows
Platform)

Xbox One

Switch Unity for Switch 0.6.1

Wii U Unity 5.4.2f2

e \WG-32536 Nintendo Switch

e WG-32623 Android



Wwise Unity Integration 2016.2.2.6022.430

Wwise 2016.2.2 Wwise SDK

e Wwise SDK: 2016.2.2
e Unity: Unity 5.5Personal Pro

Q Unity 4

Wwise Unity Integration

Android
I0S
Linux
Mac
PS4
PS Vita Unity 5.5.0p4
tvOS

Windows

Windows Store (Universal Windows
Platform)

Xbox One

Wii U Unity 5.4.2f2

e WG-31862



Wwise Unity Integration 2016.2.1.5995.409

2016.2.1 Wwise SDK

e Wwise SDK: 2016.2.1
e Unity: Unity 5.5Personal Pro

Q Unity 4

Wwise Unity Integration

Android
I0S

Linux
Mac

PS4

PS Vita
tvOS
Windows
Windows Store (Universal Windows
Platform)
Xbox One

Unity 5.5.013

Wii U

Unity 5.4.22

e WG-32006 GameObject "Unknown Game Object ID"




Wwise Unity Integration 2016.2.1

2016.2.1 Wwise SDK

e Wwise SDK: 2016.2.1
e Unity: Unity 5.5Personal Pro

Q Unity 4

Wwise Unity Integration

Android
I0S

Linux
Mac

PS4

PS Vita
tvOS
Windows
Windows Store (Universal Windows
Platform)
Xbox One

Unity 5.5.0f3

Wii U

Unity 5.4.2f2

WG-27085 AuxSends
WG-31127 AK_MusicSyncUserCue
WG-31650

WG-31862

AkGameObj NullReferenceException
WG-31651 SetObjectPosition AkGameObj

Unity case #861189 Unity Windows Store Launcher



https://fogbugz.unity3d.com/default.asp?861189_deb0tebbc8rt0vl0

Wwise Unity Integration 2016.2.0

Wwise 2016.2.0 Wwise SDK

e Wwise SDK: 2016.2.0
e Unity: Unity 5.4Personal Pro

;J Unity 4

Wwise Unity Integration

Android
I0S

Linux
Mac

PS4

PS Vita
tvOS
Windows
Windows Store (Universal Windows
Platform)
Xbox One

Unity 5.4.1p2

Wii U

Unity 5.2.4f1

Windows Phone 8.1Windows Store 8.0 8.1 Windows

Store Universal Windows Platform (UWP)

Xbox 360
PS3

WG-30571 Library Wwise Unity
WG-30960 AkGameObj Unity

WG-31507 MedialD bStreaming duration




Wwise Unity Integration 2016.1.3

Wwise 2016.1.3 Wwise SDK

e Wwise SDK: 2016.1.3
e Unity: Unity 5.4Personal Pro
Unity 4 Unity 4 Wwise
Integration

| “Wwise Unity Integration

Android

I0S

Linux

Mac

PS3

PS4 Unity 5.4.0p2
PS Vita

tvOS

Windows
Windows Store
Xbox One

Wii U |Unity 5.2.4f1

IXbox 360 [unity 5.0.1f1




Wwise Unity Integration 2016.1.2

Wwise 2016.1.2 Wwise SDK Wwise Unity

e Wwise SDK: 2016.1.2
e Unity: Unity 5.4Personal Pro

Q Unity 4

| “Wwise Unity Integration

Android

I0S

Linux

Mac

PS3

PS4 Unity 5.4.0p2
PS Vita

tvOS

Windows
Windows Store
Xbox One

Wii U |Unity 5.2.4f1

IXbox 360 [unity 5.0.1f1

e WG-30567 WAV

e SWIG ZIP SWIG SWIG
e Wwise 2014.1.4 2016.1 2015.1.6 2016.1

e Unity Unity 5.4 Wwise 2016.1.2Unity 5.4
Wwise 2016.1.2



Wwise Unity Integration 2016.1.1

Wwise 2016.1.1 Wwise SDK

e Wwise SDK: 2016.1.1
e Unity: Unity 5.3Personal Pro

Q Unity 4

| “Wwise Unity Integration

Android

I0S

Linux

Mac

PS3

PS4 Unity 5.3.5p6
PS Vita

tvOS

Windows
Windows Store
Xbox One

Wii U |Unity 5.2.4f1

IXbox 360 [unity 5.0.1f1

WG-30021 SoundBank

WG-30228 Linux

WG-30231 tvOS

WG-30259 GC.Collect AkGameObj

WG-30128 Vita SoundBank



e WG-30139Vita



Wwise Unity Integration 2016.1

Wwise 2016.1 Wwise SDK

e Wwise SDK: 2016.1
e Unity: Unity 5.3Personal Pro

Q Unity 4

| “Wwise Unity Integration

Android
i0S
Linux
PS3

Mac
PS4 Unity 5.3.4p3

PS Vita

Windows

Windows Store

Xbox One

wii U Junity 5.2.411
IXbox 360 [unity 5.0.1f1

e WG-25675 Wwise Picker “Generate SoundBanks”
Wwise SoundBank

e WG-27583 Unity assets SoundBank Unity
SoundBank

WG-28175 WwiseGlobal

WG-26011 Ak Audio Listener Default Unity Audio
Listener



SWIG ZIP SWIG SWIG
Wwise 2014.1.4 2016.1 2015.1.6 2016.1

WG-30021 Editor DecodeBanks
WG-30021DecodeBanks SoundBank DecodedBanks

WG-30128 Vita SoundBank
WG-30128 WiiU SoundBank



Wwise Unity Integration 2015.1.4

2015.1.4 Wwise SDK

e Wwise SDK: 2015.1.4
e UnityUnity 4.6 Pro Unity 5.2 (Personal Pro)

||Wwise Unity Integration

Android

I0S

Linux

Mac

Metro

PS3 Unity 5.2.2p1
PS4

PS Vita
Windows
Windows Phone
Xbox One

Wii U |Unity 4.3.7f1 Wii U add-on 2.2.5

Xbox 360 Junity 5.0.1f1

o WG-28412 AkGameObj
e WG-28723 PS4



Wwise Unity Integration 2015.1.3

Wwise 2015.1.3 Universal Windows Platform Wwise SDK

e Wwise SDK: 2015.1.3
e UnityUnity 4.6 Pro Unity 5.2 (Personal Pro)

||Wwise Unity Integration

Android
i0S
Linux
PS3

Mac

PS4 Unity 5.2.2p1
PS Vita

Windows

Windows Store Apps

Xbox One

wii U Junity 4.3.7f1 wii U add-on 2.2.5
[Xbox 360 Junity 5.0.111

Windows Store Apps Universal Windows Platform
Windows Store Apps SDK 8.1

Windows Phone 8.0

Windows Store Apps SDK 8.0

WG-25945 Wwise Unity WwiseGlobal Unity

/ Wwise

WG-26011 Ak Audio Listener Default Unity Audio
Listener

WG-28108

WG-28175 WwiseGlobal



e WG-28479 Main Camera
e WG-28526 Unity Editor GameObjects
SoundEngine



Wwise Unity Integration 2015.1.2

Wwise 2015.1.2 Wwise SDK

e Wwise SDK: 2015.1.2
e UnityUnity 4.6.5 Pro Unity 5.1.2p2 (Personal Pro)
: ||Wwise Unity Integration |

Android
I0S
Linux
Mac
Metro
PS3 Unity 5.2.0f3
PS4

PS Vita

Windows

Windows Phone

Xbox One

Wii U |Unity 4.3.7f1 Wii U add-on 2.2.5
Xbox 360 Junity 5.0.1f1

o WG-27029 Unity GameObject AkGameODbj

e WG-28200 Everything (0, 0, 0) GameObjects 3D
mask LO



Wwise Unity Integration 2015.1.1

Wwise 2015.1.1 Wwise SDK

e Wwise SDK: 2015.1.1
e UnityUnity 4.6.5 Pro Unity 5.1.2p2 (Personal Pro)

||Wwise Unity Integration |

Android
I0S
Linux
Mac
Metro
PS3 Unity 5.1.2p2
PS4

PS Vita

Windows

Windows Phone

Xbox One

Wii U |Unity 4.3.7f1 Wii U add-on 2.2.5
Xbox 360 Junity 5.0.1f1

WG-27977 Unity

WG-28030 Wii U/Unity TRC
WG-28042 Unity Wwise
WG-28044 UnityWwise
WG-28046 AklInitializer
WG-28048 Wwise GameObject



Wwise Unity Integration 2015.1

Wwise 2015.1 Wwise SDK

e Wwise SDK: 2015.1

e WG-25669Wwise Picker Auto Populate Mac Editor

e WG-27079 WwiseSettings.xml



Wwise Unity Integration 2014.1.6

2014.1.6 Wwise SDK

e Wwise SDK: 2014.1.6
e UnityUnity 4.6.5 Pro, Unity 5.0.2 (Personal Pro)

| “Wwise Unity Integration

Android

I0S

Linux

Mac

Metro .

PS3 Unity 5.0.2p3
PS4

PSVita

Windows

Windows Phone

Xbox 360 |Unity 5.0.1f1
Xbox One ||Unity 5.0.2p4

o WG-27585 Wwise Picker Wwise
e WG-27624 (PS3) SetListenerPostion PS3

Unity

e Xbox OneSoundEngine Unity

o Windows Store Apps in Unity 4  D11NotFoundException

e WG-27585 Wwise Picker Wwise



Wwise Unity Integration 2014.1.5

Wwise 2014.1.5 Wwise SDK

e Wwise SDK: 2014.1.5
e UnityUnity 4.6.5 Pro, Unity 5.0.2 (Personal Pro)

| “Wwise Unity Integration

Android

I0S

Linux

Mac

Metro .

PS3 Unity 5.0.2p3
PS4

PSVita

Windows

Windows Phone

Xbox 360 |Unity 5.0.1f1
|Xbox One ||Unity 5.0.2p4

o WG-25669Wwise Picker Auto Populate Mac Editor
Unity

e Xbox OneSoundEngine Unity
e Windows Store Apps in Unity 4  D11NotFoundException

e Android x86
e Windows Store Apps Scripting Define Symbols



e WG-27108 Destroy Unity
e WG-25733 Windows i0S/Mac
e WG-26875 AkMemBankLoader



Wwise Unity Integration 2014.1.4

Wwise 2014.1.4 Wwise SDK Unity 5

Wwise SDK: 2014.1.4
UnityUnity 4 Pro Unity 5Personal Pro

WG-26780 Wwise Unity
WG-26837 AkBankManager SoundBank

WG-25669Wwise Picker Auto Populate Mac Editor
WG-25733 Windows iOS/Mac

Windows Phone 8.1 Metro
Unity 5 Wwise Unity Integration Plugin Importer API
<UNITY_PROJECT_ROOT>/Assets/Plugins

Unity 4 Unity 5

Unity 5 Unity 4 Unity
Unity 5 2014.1.4 Unity

Unity 5 Wwise Unity Integration



Wwise Unity Integration 2014.1.3

Wwise 2014.1.3 Wwise SDK

e Wwise SDK: 2014.1.3

e WG-25669Wwise Picker Auto Populate Mac Editor
e WG-25733 Windows iOS/Mac



Wwise Unity Integration 2014.1.2

Wwise 2014.1.2 Wwise SDK

Wwise SDK: 2014.1.2
XDK Unity Editorl0 XDK Wwise SDK11 XDK
Xbox One

WG-26305 null GameObject 64 GameObject
WG-26337 Mac 64

WG-26385 Wwise Android Unity CPU
WG-26395 MSBUILD Windows Phone 8
WG-26430 i0OS SetBasePath()

WG-25669Wwise Picker Auto Populate Mac Editor
WG-25733 Windows iOS/Mac



Wwise Unity Integration 2014.1.1

Wwise 2014.1.1 Wwise SDK

Wwise SDK: 2014.1.1
Unity: 4.x 5.0

Wii U

Plug-in Registration

Unity "Wwise Settings" Wwise Sound Engine
GeneratedSoundBanks Populate

WG-26201 C# System

WG-25669Wwise Picker Auto Populate Mac Editor
WG-25733 Windows iOS/Mac

WG-25669Wwise Picker Auto Populate Mac Editor
WG-25733 Windows iOS/Mac



Wwise Unity Integration 2014.1

Wwise 2014.1 Wwise SDK Demonstration
Wwise Unity Integration 2013.2

e Wwise Unity Integration 2013.2

e Wwise SDK: 2014.1
e Unity: 4.x

e Android
e IOS
e Linux
o 32
o 64
Mac OS X10.6
PS3
PS4
PS Vita
Windows
o 32
o 64
¢ Windows 8Metro
o Desktop
o Intel Windows Store App ARM
e Windows Phone 8.0
e Xbox360
e Xbox One



pg_wwisedemoscene
Wwise Unity Integration 2013.2
Wwise Components Wwise Unity Integration UUID
Wwise Project Unity
Wwise Events Trigger
Wwise inspector AkAmbient
AkSoundEngine
WwiseGlobal AkListener

WG-25783 Callback Manager
WG-25677 Mac

WG-25669Wwise Picker Auto Populate Mac Editor
WG-25733 Windows iOS/Mac



Wwise Unity Integration 2013.2.9

Wwise 2013.2.9 Wwise SDK

Wwise SDK: 2013.2.9
Unity: 4.x

Android
I0S
Linux
o 32
o 64=
Mac OS X10.6
PS3
PS4
PS Vita
Windows
o 32
o 64
Windows 8Metro
o Desktop
o Intel Windows Store App ARM
Windows Phone 8.0
Xbox360
Xbox One

Windows Phone 8.0



Wwise Unity Integration 2013.2.8

Wwise 2013.2.8 Wwise SDK Wwise-Unity

Unity
Wwise Picker Wwise Wwise Picker
Unity Wwise Unity
Wwise-Unity Integration Wwise SDK

¢ Wwise SDK: 2013.2.8
e Unity: 4.x

e Android
e IOS
e Linux*
o 32
o 64
Mac OS X10.6
PS3
PS4
PS Vita
Windows
o 32
o 64
¢ Windows 8Metro
o Desktop
o Intel Windows Store App ARM
e Windows Phone 8.0
e Xbox360
e Xbox One



Xbox One

PS4

Linux * Unity Integration for Linux is supported in Wwise
2013.2.8 Linux BETA.

Windows Phone 8.0

Multi-architecture Windows Metro Unity Scripting
Define Symbol

Unity Editor Integration

Integration

Windows IDE Visual Studio 2008 2010
Windows Metro



Wwise Unity Integration 2013.2.5

Wwise 2013.2.5 Wwise SDK

e Wwise SDK: 2013.2, 2013.2.X
e Unity: 4.x

Android
I0S
Mac OS X10.6
PS3
PS4
PS Vita
Windows
o 32
o 64
¢ Windows 8Metro
o Desktop
o Intel Windows Store App ARM
e Xbox 360
e Xbox One

PS4

PS Vita

Xbox One

Android APl  AddBasePath() /O POSIX

e WG-24351i0S



Wwise Unity Integration 2013.2.4

Wwise 2013.2.4 Wwise SDK

e Wwise SDK: 2013.2, 2013.2.X
e Unity: 4.x

e Windows 8Metro
o Desktop
o Intel Windows Store App ARM
e Windows
o 32
o 64
Mac OS X10.6
I0S
Android
Xbox360
PS3

e Wwise > Help Integration
e Version.txt Wwse SDK

e WG-24080 Windows Mac APl Android

Android armeabi



Wwise Unity Integration 2013.2.1

2013.2.1 Wwise SDK overhauled distribution

e Wwise SDK: 2013.2, 2013.2.1
e Unity4.x 3.x

e Windows 8Metro
o Desktop
o Intel Windows Store App ARM
e Windows
o 32
o 64
Mac OS X10.6
I0S
Android
Xbox360
PS3

e Unity Integration Unity Unity Editor
e Unity Editor Ul Wwise
o Integration
o SoundBank ID C++ header C#
Unity 4 Scripting Define Symbols Windows
Integration
IntegrationDemo
AndroidSoundBank Android Expansion FilesOBB

e WG-23781


http://docs.unity3d.com/Documentation/Components/class-PlayerSettings40.html
http://developer.android.com/google/play/expansion-files.html

WG-23734 Windows
WG-23345 Unity Editor
WG-23436Unity
WG-23423Unity GameObijects
WG-22533Unity API

I0S
Unity
BUILD THE APPLICATION FOR A MULTI-ARCHITECTURE
PLATFORM
IOS Xcode API I0S
Ul
Apple

SWIG 2.0.11Mac pg_compileswig SWIG


https://www.audiokinetic.com/library/2015.1.9_5624/?source=Unity&id=pg__howtobuildmultiarch.html

Wwise Unity Integration 2013.1.1

Wwise 2013.1.1 Wwise SDK Integration



Wwise Unity Integration 2013.1

Wwise 2013.1 Wwise SDK Android

e Wwise SDK: 2012.2.x, 2013.1
e Unity: 3.4.x, 3.5.%, 4.X

e Windows 8
o Desktop
o Intel Windows Store App ARM
Windows32
Windows64
Mac OS X10.6
I0S
Android
Xbox360
PS3

e AndroidSoundBank Android apk LoadBank() API

e \Windows 64
e \Windows 8

WG-22948 PS3

WG-22938 Mac OSX Unity Integration
WG-22334Music userCue Unity
WG-22329Unity Integration PostEvent()
WG-22255Unity Android

WG-221653D iOS Android
WG-21933AkCallbackManager.cs UserCue



WG-21365Unity iOSiOS
WG-22533 API

Windows Mac Unity

Python
Integration Unity

Visual Studio 2010 PS3 Integration

Python 2.6 Python 2.7.x 3.x

Integration UNITY_PROJECT_ROOTIntegration
UNITY_PROJECT_ROOT

Android PostprocessBuildPlayer Unity
IntegrationDemo Unity 4

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by dﬂlxggn 1.6.3
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2017.2

Wwise 2017.1 Unity

o Edit Mode Support
o Loading and Unloading Banks in Edit Mode
Additions to WwiseGlobal Game Object
Wwise Audio Input Plug-in
MIDI Events
Automatic SoundBank Management



Edit Mode Support

The Wwise sound engine is now initialized while Unity is in Edit mode.
This means Wwise Events can be triggered from the editor without
entering Play mode. In order to demonstrate this, the inspectors for
AkEvent (and AkAmbient) have been updated. There are now buttons in
the inspector that can be used to play and stop the Events directly from
the editor. The Play/Stop button plays and stops individual Events. When
multiple objects that have AkEvents are selected, the Play Multiple and
Stop Multiple buttons play or stop all currently selected Events. The Stop
All button stops all currently playing Events.

v Ak Ambient (Script)

Trigger On; AkTriggerButtonPress

Action On Event:

Callback Functic Callback Flags

g @ MarkerCallback |Marker

Fosition Type:

Show Attenuation Sp! Dont_Show

Event Name: PlaySubtitles

Loading and Unloading Banks in Edit Mode

Note that in order for the edit mode functionality to work correctly, the
corresponding AkBank components should have their Load On: property
set to Awake and their Unload On: property set to Never.



Additions to WwiseGlobal Game Object

The WwiseGlobal game object now has an AKEditorEventPlayer
component. This component is editor only, and is used to play
WwiseEvents that are associated to AKEvent components in Edit mode.
The WwiseGlobal object also now has Rigidbody, AkGameobj, and
AkAudioListener components. These are used for interactions between
AKEnvironment, AkGameObj, and AkRoom components in Edit mode.

Unity



Wwise Audio Input Plug-in

The Wwise Audio Input Source Plug-in is now accessible via C#
scripting. Using the Audio Input Source Plug-in in Unity.



MIDI Events

MIDI events can now be posted to Wwise via C# scripting. Sending
MIDI to Wwise.



Automatic SoundBank Management

Automatic SoundBank management has been added.
SoundBanks SoundBank



Spatial Audio Integration

Added spatial audio API to the Unity integration. See Using Wwise
Spatial Audio in Unity for a tutorial.
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ErrorCode "AK.

Monitor.ErrorCode

Monitor.ErrorLevel

ErrorLevel "AK.

DynamicSequenceType[[AK.

SoundEngine.DynamicSequence.DynamicSequenceT)

MultiPositionType “AK.

SoundEngine.MultiPositionType

PreparationType Ak

SoundEngine.PreparationType

SoundEngine.Query.RTPCValue_type

RTPCValue_type “AK.
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Iterator "AkIterator
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Wwise 2017.1 Unity

[ ]

o WwiseTypes

¢ Unity Integration Extensions
e 3D



[RequireComponent(typeof(AkGameObj))] AkEvent

AKEnvironment AkEnvironmentPortal Rigidbody Rigidbody
AKEnvironment AKEnvironmentPortal Rigidbody
AkGameObj "Environment aware" Rigidbody Editor
AkGameObj-AKEnvironment interactions require a Rigidbody
component on the object or the environment.

Wwise Settings Show Warning for Missing RigidBody
Wwise v20°0 © © Build ® ¢ Settings.
Wwise Project
| Wwise Project Path*: JAWwiseProject\WwiseProject.wproj l:”
Wwise Windows Installation Path
| Wwise Windows Installation Path: Cih\dev'wwise_main l:”
Asset Management
SoundBanks Path* (relative to StreamingAssets folder): |Audio\GeneratedSoundBanks :J

o Create WwiseGlobal GameObject
[ Automatically add Listener to Main Camera

In Editor Warnings

|IEShow Warning for Missing RigidBody

* Mandatory settings




WwiseTypes

"WwiseTypes"” Wwise Eventgame parameterSwitch
State Wwise Picker

7 || ¥ Footsteps (Script) - ﬁ ,
Script Footsteps @
Wwise Types
Foot Step Event [ Footstep ]
Foot Step Speed | Mo GameParameter is currently selected |
Under Foot Material | Mo Switch is currently selected |

public class Footsteps : MonoBehaviour
{
[Header ("Wwise Types")]
public AK.Wwise.Event FootStepEvent = null;
public AK.Wwise.RTPC SpeedRTPC = null;
public AK.Wwise.Switch UnderFootMaterialSwitch =
null;
public AK.Wwise.Bank FootStepBank = null;

void InitializeSound() { FootStepBank.Load(); }
void FinalizeSound() { FootStepBank.Unload(); }

void PlayFootStepSound(float speed)

{
SpeedRTPC.SetValue(gameObject, speed);
UnderFootMaterialSwitch.SetValue(gameObject)
’
FootStepEvent.Post(gameObject);
}



Unity Integration Extensions

AkSoundEngine Launcher


https://www.audiokinetic.com/library/edge/?source=InstallGuide&id=integrating_wwise_into_an_unreal_or_unity_project

3D

Wwise 3D AkGameObj AkAudioListener
AkGameObj AkAudiolListener

7 || # Ak Audio Listener (Script) [ %
| Is Default Listener [ |

T v Ak Game 0bj (Script) [l .
|App|'gr Position Offset[ | |

| Environment Aware: [ |

Initial Listener List [wUse Default Listeners
Listener 0 INune_{Ak_ Audio Listener) ! 8
Add Listener ]

M & i - o 1 e
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AkCallbackManager

® AkCallbackManager .AudioInterruptionCallback()

public delegate AKRESULT AudioInterruptionCallba
ck(bool in_bEnterInterruption, object in_Cookie)

14
® AkCallbackManager .BGMCallback() :

public delegate AKRESULT BGMCallback(bool in_bOt
herAudioPlaying, object in_Cookie);

® AkCallbackManager.EventCallback() :

public delegate void EventCallback(object in_coo
kie, AkCallbackType in_type, AkCallbackInfo in_1i
nfo);

° AkCallbackManager AkCallbackInfo C++

o gameObjID ulong IntPtr

® AkCallbackManager.AkMidiEventCallbackInfo
AkMIDIEventCallbackInfo "MIDI"

® AkCallbackManager .AkMusicSyncCallbackInfoBase
AkMusicSyncCallbackinfo

e AkcallbackManager.AkMusicSyncCallbackinfo.segmentinfo
AkMusicSyncCallbackInfo.segmentInfo_*
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Unity

wwiseUnityIntegration UnityPackage Unity Editor
Wwise Unity

Wwise
Unity

SoundBank

| Wwise
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Wwise

Unity
|
Unity 5.5 (Personal Pro) |
i0S Xcode 7.2 i0S SDK |
Linux libSDL2 ( Linux ) |
\Windows Direct_X End—Usgr runtime o
x64 Visual Studio 2013 redistributable
Windows 32- Debug x86 Visual Studio 2013 redistributable|
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Wwise

Wwise Launcher Wwise Launcher Wwise Unity

e Unity Launcher
o Wwise Unity
e Unity check out Unity


https://www.audiokinetic.com/library/edge/?source=InstallGuide&id=integrating_wwise_into_an_unreal_or_unity_project

Unity Integration Extensions

partial Launcher
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Unity
Unity

® Edit > Project Settings > Audio Disable Audio

e "Create WwiseGlobal GameObiject" "Wwise Global”
AkInitializer AkTerminator WwiseThe WwiseGlobal
object is also given AkEditorEventPlayer, AkAudioListener and
AkGameONbj scripts which are used for previewing AKEvent objects
in edit mode. A Rigidbody component is added such that interactions
between AKEnvironment, AkRoom and AkGameObj can also be
previewed.

e Script Execution Order Wwise AkInitializer AkGameObj
AkAudioListener AkBank AkTerminator  "Add Ak Listener to
Main Camera" Unity Audio Listener Main Camera

AkAudioListener.cs Main Camera
e play in Background Wwise Profiler
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Wwise Wwise SoundBank Wwise

1. WAV Windows Explorer WAV Project Explorer
Audio

2. Sound New Event

3. SoundBank SoundBanks F7 New

4. SoundBank Event Project Explorer SoundBank

5.  Generate SoundBanks

Unity

1. Wwise Picker Window > Wwise Picker Events
SoundBanks

2. SoundBank

3. Event

4.



Unity Wwise Unity

° AkAmbient
e AkBank SoundBank
] AKEnvironment
[ J
Wwise API

¢ Integrate Wwise Elements into Your Game
e AK::SoundEngine Namespace Reference
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SoundBank

Unity Editor Wwise GeneratedSoundBanks
SoundBank
Unity ... SoundBankWwise SoundBankTo avoid

packaging the SoundBanks for all platforms with your game, you should
enable the automatic generation of SoundBanks or use a
BuildPlayerPipeline script. Unity
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Wwise Unity SoundBank

Wwise

SoundBank

Unity

SoundBank StreamingAssets

Unity

Wwise Compressor
Wwise Delay

Wwise Expander
Wwise Gain

Wwise Matrix Reverb
Wwise Meter

Wwise Parametric EQ
Wwise Peak Limiter
Wwise RoomVerb
Wwise Silence

Wwise Sine

Wwise Tone Generator

7

Wwise Unity

Wwise McDSPiZotopeAuroSoundSeedCrankcase REV
Convolution ReverbMotion Wwise
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| Wwise

e Unity Unity
f e Unity check-out Unity
@ . Wwise Unity
e C++ AkSoundEngine C++ Wwise SDK
Wwise |/
Wwise Unity Wwise  Unity Wwise

Wwise Launcher Wwise
, Wwise Wwise
-

2 Wwise Unity

C++



Wwise

1. Wwise Wwise Unity Wwise

e Wwise

=

Wwise “Yes”
2. Unity Wwise SoundBank



Unity Wwise

Unity Wwise Wwise Launcher
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Wwise Unity Assets/Wwise Wwise
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Wwise Unity

AkAmbient Use this component to attach a Wwise Event to any
object in a scene. The sound can be started at various moments,
dependent on the selected Unity trigger. This component is more
useful for ambient sounds (sounds related to scene-bound objects)
but could also be used for other purposes. Since AkAmbient has
AKEvent as its base class, it features the play/stop, play multiple,
stop multiple and stop all buttons for previewing the associated
Wwise event. . inspector AkAmbient

AkAudioListener

Add this script on the game object that represent a listener. This is
normally added to the Camera object or the Player object, but can be
added to any game object when implementing 3D busses.
isbDefaultListener determines whether the game object will be
considered a default listener - a listener that automatically listens to
all game objects that do not have listeners attached to their
AkGameObijListenerList's.

AkBank

Loads and unloads a SoundBank at a specified moment. Vorbis
sounds can be decompressed at a specified moment using the
decode compressed data option. In that case, the SoundBank will be
prepared.

AKEmitterObstructionOcclusion

Obstructs/Occludes the emitter of the current game object from its
listeners if at least one object is between them.

AKEnvironment

Use this component to define a reverb zone. This needs to be added
to a collider object to work properly. inspector AKEvironment
AKEvironmentPortal

AKEnvironmentPortal

Use this component to define an area that straddles two different
AKEnvironments zones and allow mixing between both zones.
inspector AKEvironment AkEvironmentPortal

AKEvent

Wwise Unity inspector Ak



AkGameObj

This component represents a sound object in your scene tracking its
position and other game syncs such as Switches, RTPC and
environment values. You can add this to any object that will emit
sound, and it will be added to any object that an AkAudioListener is
attached to. Note that if it is not present, Wwise will add it
automatically, with the default values, to any Unity Game Object that
is passed to Wwise.

AkRoom

An AkRoom is an enclosed environment that can only communicate
to the outside/other rooms with AkRoomPortals.

AkRoomPortal

Loads and unloads a SoundBank at a specified moment. Vorbis
sounds can be decompressed at a specified moment using the
decode compressed data option. In that case, the SoundBank will be
prepared.

AKEmitterObstructionOcclusion

Obstructs/Occludes the spatial audio portal of the current game
object from the spatial audio listener if at least one object is between
them.

AkSpatialAudioEmitter

Add this script on the GameObject which represents an emitter that
uses the Spatial Audio API.

AkSpatialAudioListener

Add this script on the game object that represent a listener. This is
normally added to the Camera object or the Player object, but can be
added to any game object when implementing 3D busses.
isbDefaultListener determines whether the game object will be
considered a default listener - a listener that automatically listens to
all game objects that do not have listeners attached to their
AkGameObijListenerList's.

AkState

This will call AksoundEngine.SetState() whenever the selected Unity
event is triggered. For example this component could be set on a
Unity collider to trigger when an object enters it.
AkSurfaceReflector

This component will convert the triangles of the GameObject's
geometry into sound reflective surfaces.

AkSwitch



This will call AksoundEngine.SetsSwitch() whenever the selected Unity
event is triggered. For example this component could be set on a
Unity collider to trigger when an object enters it.

Wwise Picker

AK.Wwise.AuxBus

This type represents an auxiliary send in the Master-Mixer Hierarchy.
AK.Wwise.Bank

This type can be used to load/unload SoundBanks.
AK.Wwise.CallbackFlags

This type represents the values of the flags used when posting an
Event with a callback.

AK.Wwise.Event

This type can be used to post Events to the sound engine.
AK.Wwise.RTPC

This type can be used to set game parameter values to the sound
engine.

AK.Wwise.State

This type can be used to set Wwise States.

AK.Wwise.Switch

This type can be used to set Switch values on gameobjects.
AK.Wwise.Trigger

This type can be used to post triggers to the sound engine.

Wwise Types



Wwise

Wwise Picker. Event Wwise Picker Unity Viewer
Inspector Game Object AKAN
Add Component AkAmbient AkEvent Unity
Game Object
Wwise Types C# AK.Wwise.Event.Post ()
C# AkSoundEngine.PostEvent()



inspector AkAmbient

o AkAmbient:
o Trigger On
Unity Unity Wwise
AkSoundEngine.PostEvent
Trigger
o Event Name:
Wwise

o Action On Event
Unity Wwise
= Action On Event Type
m Curve Interpolation:
m Fade Time:
o Use Callback:
m Game Object

m Callback Function:
Game Object Callback Fur
Game Object Callback Function
void FunctionName(AkEventCallbackMsg i
m Callback Flags:

Callback Function Wy
AkCallbackType
o Play | Stop:
Can be used to preview the Wwise Event when in Edit mode.
o Stop All:

Stops all currently playing Wwise events.
o Position Type

= Simple_Mode


https://www.audiokinetic.com/library/?source=SDK&id=_ak_callback_8h_a948c083ff18dc4c8dfe1d32cb0eb6732.html

m [arge Mode
Add y
m MultiPosition _Mode

AkAmbient
AkAmbient
AkAmbient Unity Ak
On AKkAmbient AKkAmbient
= Show Attenuation Sphere:
Wwise SoundBank Max

AttenuationProject->Project Settings->Soundbanks-
>Max attenuation
= Dont_Show

m Current_Event_Only
AkSoundEngine.PostEvent

Simple_Mode

Large Mode

MultiPosition_Mode MultiPosition_Mode

AkAmbient
m All Events
AkAmbient



Using Wwise with Unity Timeline

For Unity's Timeline feature, there are custom Wwise tracks for triggering
Wwise events and setting Wwise RTPC values.

Wwise Timeline Integration



inspector AKEvironment
AKEvironmentPortal

Wwise Reverb Zone Environment Auxiliary Sends
Reverb Zone Wwise

AKEnvironment AKEnvironment AKEnvironment

° Wwise Picker AKEnvironment AuxBus Wwise
Picker Unity Viewer Inspector Game Object
AKEnvironment

e "Add Component" AKEnvironment Unity Game
Object Inspector
o C# AkSoundEngine.SetGameObjectAuxSendValues()
portal

e Unity GameObject->Wwise->Environment Portal

environment aware AkGameObj
AKEnvironmentPortal AKEnvironment inspector

Wwise 4 4

o 4

o 4
o 4 Default Exclude Others
o Default
o  Exclude Others

e AKEnvironment
4
o Priority:

4 4



o DefaultDefault:

o Exclude Others

Exclude Others
Exclude Others
o AuxBus Name
AuxBus AuxBus AuxBus AuxBus
AuxBus Ok AuxBus Wwise Picker AuxBus
AuxBus

e AKEnvironmentPortal
Unity GameObject->Wwise->Environment Portal

Environment #1

(¢]

Environment #2

o

(¢]

AXxis

Z X Z

AK::SoundEngine::SetGameObjectAuxSendValues


https://www.audiokinetic.com/library/?source=SDK&id=integrating__elements__environments.html
https://www.audiokinetic.com/library/?source=SDK&id=namespace_a_k_1_1_sound_engine_a18f56e8e0e881c4efb9080545efbb233.html

C#

Wwise SDK AkSoundengine Unity C++

AK: :SoundEngine AK::MusicEngine SDK API API

Wwise API GameObjec
GameObject AkGameODbj

Event Bank ID

Wwise APl ID Wwise C# Wwise IDs.h
wwise IDs.cs Assets > Wwise > Convert Wwise SoundBank IDs
Python

Sending MIDI to Wwise.

MIDI can be sent to Wwise by filling the AkmipIPost members of
AKMIDIPostArray class and calling any of the following methods:

® AKMIDIPostArray.PostOnEvent()
® AkSoundEngine.PostMIDIOnEvent()
® AK.Wwise.Event.PostMIDI()

The following is a basic script that sends MIDI messages to the sound
engine:

public class MyMIDIBehaviour : UnityEngine.MonoBehav
iour
{

public AK.Wwise.Event SynthEvent;

private void Start()
{
AKMIDIPostArray MIDIPostArrayBuffer = new Ak
MIDIPostArray(6);
AKMIDIPost midiEvent = new AKMIDIPost();

midiEvent.byType = AKMIDIEventTypes.NOTE_ON;



midiEvent.byChan = 0;
midiEvent.byOnOffNote = 56;
midiEvent.byVelocity = 127;
midiEvent.uOffset = 0;
MIDIPostArrayBuffer[0] = midiEvent;

midiEvent.byOnOffNote = 60;
MIDIPostArrayBuffer[1] = midiEvent;

midiEvent.byOnOffNote = 64;
MIDIPostArrayBuffer[2] = midiEvent;

midiEvent.byType = AKMIDIEventTypes.NOTE_OFF

midiEvent.byOnOffNote = 56;
midiEvent.byVelocity = 0;
midiEvent.uOffset = 48000 * 8;
MIDIPostArrayBuffer[3] = midiEvent;

midiEvent.byOnOffNote = 60;
MIDIPostArrayBuffer[4] = midiEvent;

midiEvent.byOnOffNote = 64;
MIDIPostArrayBuffer[5] = midiEvent;

SynthEvent .PostMIDI(gameObject, MIDIPostArra
yBuffer);

}
}
Using the Audio Input Source Plug-in in Unity.

The audio input source plug-in can be used via C# scripting. See Audio
Input Source Plug-in from the Wwise SDK documentation.

The following is a basic script that sends a test tone to the audio input
source plug-in:


https://www.audiokinetic.com/library/edge/?source=SDK&id=referencematerial__audioinput.html

public class MyAudioInputBehaviour : UnityEngine.Mon
oBehaviour
{

public AK.Wwise.Event AudioInputEvent;

public uint SampleRate = 48000;

public uint NumberOfChannels = 1;

public uint SampleIndex = 0;

public uint Frequency = 880;

private bool IsPlaying = true;

// Callback that fills audio samples - This func
tion is called each frame for every channel.

bool AudioSamplesDelegate(uint playingID, uint c
hannelIndex, float[] samples)

{

for (uint 1 = 0; 1 < samples.Length; ++1i)
samples[i] = UnityEngine.Mathf.Sin(Frequ

ency * 2 * UnityEngine.Mathf.PI * (i1 + SamplelIndex)
/ SampleRate);

1t (channelIndex == NumberOfChannels - 1)
SampleIndex = (uint)(SampleIndex + sampl
es.Length) % SampleRate;

// Return false to indicate that there is no
more data to provide. This will also stop the assoc
iated event.
return IsPlaying;
}

// Callback that sets the audio format - This fu
nction is called once before samples are requested.
void AudioFormatDelegate(uint playingID, AkAudio
Format audioFormat)
{
// Channel configuration and sample rate are
the main parameters that need to be set.



audioFormat.channelConfig.uNumChannels = Num
berOfChannels;
audioFormat.uSampleRate = SampleRate;
}

private void Start()
{

// The AudioInputEvent event, that 1is setup
within Wwise to use the Audio Input plug-in, 1is post
ed on gameObject.

// AudioFormatDelegate 1is called once, and A
udioSamplesDelegate is called once per frame until 1
t returns false.

AKkAudioInputManager.PostAudioInputEvent (Audi
oInputEvent, gameObject, AudioSamplesDelegate, Audio
FormatDelegate);

}

// This method can be called by other scripts to
stop the callback
public void StopSound()

{
IsPlaying = false;
}
private void OnDestroy()
{
AudioInputEvent.Stop(gameObject);
}

Apply Custom Positioning in Unity

By default, the Akeameobj component is attached to a specific Unity
gameObject and uses its transform (with an optional offset) for full
positioning. This is usually adequate for many games, such as first-
person shooters. However, games with custom camera angles, such as



many third-person games, may find it difficult to accommodate the two
aspects of positioning (distance attenuation and spatialization) by simply
attaching the audio listener to one game object, such as the main camera
in Unity. Other games may want players to experience other custom
positioning.

To this end, the Akcameobj component class provides overridable
positioning to Unity users. Through the three virtual methods
GetPosition(), GetForward(), and GetUpward(), users can derive a
subclass from AkGameobj and use that subclass component to customize
any number of Unity gameobjects' positioning.

Here is a simple example of how to use a custom component to override
the default AkAudioListener behavior. With a third-person project
integrated with Wwise, remove the existing AkAudioListener and its
associated Akcameobj. Then attach the following script to the MainCamera
object, attach AkAudioListener, and finally specify the target Unity
gameObject (such as the player avatar) that the audio listener's position
will follow. After this, the distance attenuation of all the emitters will rely
on the selected target Unity gameobject's position as the listener position
(an on-screen distance listener), while the orientation of all the emitters is
still based on the main camera orientation as the listener orientation (an
off-screen orientation listener).

#if ! (UNITY_DASHBOARD_WIDGET || UNITY_WEBPLAYER || U
NITY_WII || UNITY_WIIU || UNITY_NACL || UNITY_FLASH
| | UNITY_BLACKBERRY) // Disable under unsupported pl
atforms.

//

// Copyright (c) 2017 Audiokinetic Inc. / All Rights
Reserved

//

using UnityEngine;
using System;
using System.Collections.Generic;



[AddComponentMenu ('"Wwise/AkGameObj3rdPersonCam")]
[ExecuteInEditMode] //ExecuteInEditMode necessary to
maintain proper state of isStaticObject.

public class AkGameObj3rdPersonCam : AkGameObj

{
public Transform target; // The posit
ion that this camera will be following. User can spe
cify this to the player character's Unity gameObject
in the Inspector.

// Sets the camera position to the player's posi
tion to handle distance attenuation.
public override Vector3 GetPosition ()

{
return target.GetComponent<AkGameObj> ().Get
Position ();

}

}
#endif // #if ! (UNITY_DASHBOARD_WIDGET || UNITY_WEBP

LAYER || UNITY_WII || UNITY_WIIU || UNITY_NACL || UN
ITY_FLASH || UNITY_BLACKBERRY) // Disable under unsu
pported platforms.
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Wwise Picker
Wwise Picker Wwise Events Switches Wwise Picker
Wwise Settings Edit > Wwise Settings... Unity Wwist
Wwise Wwise Picker Refresh Project Wwise
Picker Wwise SoundBank XML
Wwise Picker Picker

+ -



SoundBank

Generate SoundBanks SoundBank SoundBank Wwise Picker
SoundBanks Wwise Unity
SoundBanks generation successful WwiseUnity: SoundBanks
generation has warning(s) WwiseUnity: SoundBanks generation
error console SoundBank

. Wwise Settings Wwise Windows Installation
,{J’ Path Mac Wwise Application Unity Generate
SoundBanks Unity Wwise



Picker

Wwise Picker Game Object Inspector

Event AkAmbient
SoundBank AkBank
Switch Value AkSwitch
State Value AkState

Aux Bus AKEnvironment
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Wwise Types

Wwise Types Wwise SoundBankEventgame parameter
State SwitchWwise Types Event

Wwise Types

public class WwiseTypeskExample : UnityEngine.MonoBeh
aviour
{

public AK.Wwise.Bank MyBank = null;

public AK.Wwise.Event MyEvent = null;

public AK.Wwise.RTPC MyRTPC = null;

public void Awake()

{
MyBank.Load();
}
public void Start()
{
MyEvent.Post(gameObject);
}
private float CalculateMyValue()
{

(float)System.Math.Sin(System.Math.PI
* UnityEngine.Time.timeSincelLevellLoad);

}
public void Update()
{
MyRTPC.SetValue(gameObject, CalculateMyValue
());
}

}



inspector

‘F@ [+ Wwise Types Example {Scrilﬂ:] ﬁ i,

Script WwiseTypesExample @

My Bank | DigitalBirds |

My Event | Play Digital Bird |

My RTPC | GP Modulation |
marker WwiseTypesExample

public AK.Wwise.CallbackFlags MyCallbackFlags = null

I/

public void Start()

{
MyEvent.Post(gameObject, MyCallbackFlags, EventC
allback);

}

private void EventCallback(object cookie, AkCallback
Type type, AkCallbackInfo info)

{
1t (type == AkCallbackType.AK Marker)
{
var markerInfo = info as AkMarkerCallbackInf
0,
1t (markerInfo != null)
{
// ...
}



Maothing
Everything
EndOfEvent
EndOfDynamicsequenceltemn
Marker

Duraticn
Starvation
MusicPlaylistSelect
MusicPlayStarted
MusicSyncBeat
MusicSyncBar
MusicSyncEntry
MusicSyncExit
MusicSyncGrid
MusicSyncllserCue
MusicSyncPoint
MIDIEvent
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Wwise Events Trigger

Unity Wwise "Trigger On" Unity / Wwise
EventSwitchState Unity

AkTriggerBase C# AkTriggerBase "Trigger On"
triggerDelegate(GameObject in_target)™
Wwise *”

GetComponent<YourTriggerClass>
().triggerDelegate(GameObject in_target)

AkTriggerBase

M
<l 32

public class TriggerOnGunHit : AkTriggerBase
{

void Hit()
{
(triggerDelegate !'= null)
{
triggerDelegate(null);
}
}
}
(playerIsShot)
{
GetComponent<TriggerOnGunHit>().Hit();
}

TriggerOnGunHit Wwise
AkSoundengine.PostEvent("GunHit", gameObject) Wwise SDK



Wwise
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Wwise Timeline Integration

Timeline is Unity's cinematic editting tool. It can be used to create game-
play sequences, audio sequences, and other cinematic content.

For more information on Timeline refer to Timeline Docs.

For instructions on how to create a Timeline Asset and Timeline instance,
refer to Timeline Usage.


https://docs.unity3d.com/Manual/TimelineOverview.html
https://docs.unity3d.com/Manual/TimelineWorkflowCreatingAssetInstance.html

Wwise Timeline Tracks

The Wwise Unity Integration adds two tracks: the AKRTPC track and the
AkEvent track. The AKRTPC track is used to set Game Parameter
values, and the AkEvent track is used to post Wwise Events. AKRTPC
tracks and AkEvent tracks can be added to a Timeline in Unity using the
"Add" dropdown button.

Timeline
|Pr!view|_m| H I > I 4] |I'H

Adds

Track Group

Activation Track
Animaticn Track
Audic Track
Control Track
Playable Track

Ak Event Track
Ak RTPC Track

Adding AK tracks to Timeline

Ak Track Object Bindings

AKkEvent tracks and AKRTPC tracks have object bindings which can be
set to any Game Object. If this is left as None, the Event messages or
RTPC messages in the track will be triggered on the Game Object that
owns the Timeline (this is the Game Obiject that has a PlayableDirector
component, which is used to trigger the Timeline). If the track binding is
set to a different Game Object, the messages will be triggered on that
Game Object.

The AKRTPC Parameter Property

AKRTPC tracks have one property in their property inspector:
Parameter. This is the Wwise RTPC parameter that will be set from the
various clips in the track.



@ Inspector
| Ak RTPC Track *,

| Parameter: ration ]

RTPC Track Parameter Property

Wwise Timeline Playable Clips

The AkEvent track and the AKRTPC tracks each hold corresponding
clips: the AkEventPlayable clip and the AKRTPCPlayable clip. These
can be added to a track using the track's menu.

Timeline
I +| GameObjectTimeline (GameObject)

&0 120 180 240 200 260

nf.GamEObject
..Nune (Game Dbje] @

Copy Ctrl+C
Paste Ctrl+V
Paste Into

Duplicate Ctrl+D
Delete Delete

Lock L
Mute

Adding AK clips to AK tracks
Timeline Clip Properties

All clips in Timeline have timing properties that are displayed in the top
portion of the inspector. For more information on these properties, refer to
Clip Properties.

AKRTPCPIlayable Clip Properties

The following properties are accessible from the inspector of an
AKRTPCPlayable clip:


https://docs.unity3d.com/Manual/script-EditorClip.html

¥ Ak RTPC Playable

Set RTPC Globally: -
Owverride Track Object: [
RTPC Object: #Mone (Game Object) = B
¥ Animated Value:
RTPC Value 0

AKRTPCPlayable Clip Properties

Set RTPC Globally: If this is checked, the RTPC will be set globally
for all objects.

Override Track Object: If this is checked, the RTPC will be set for
the selected Game Object in the RTPC Object property (only
available when Set RTPC Globally is unchecked).

RTPC Object: The Game Object for which the RTPC will be
updated. If this is set to None, the RTPC will be set on the track
object (or the Timeline's owner object if the track object is set to
None). This is only available when Override Track Object is
checked.

Animated Value: RTPC Value: This is the value that will be
animated by the RTPC track. In order to begin animating this value
you need to arm the track for recording, set the playhead to
somewhere within the RTPCPlayable clip, and then edit the value
from the property inspector.



=) [CubeAcceleration ]
<
Clip Timing
Start 50 flo
End 5|1 f 60
Duration 5|1 f 60
Ease In Duration s : f :
Ease Out Duratior s : f :
Blend Curves
In (v [
out (v ) [

¥ Ak RTPC Playable

| setRTPC Globallyd

¥ Animated Value:

ol "
| Preview | | M| » | #1 (b | [[#][[43 |[i00 ¢ ... ttonTimeline (Button) LEne the KR wlue
i .. _somr-_-whr-_-re within the RTPC clip
PEET o a— il
= e o
Decwmet o
..CubeScuth @

Arm track for recording
..None (Game Obje| @

Animating RTPC Values from Timeline

Following these steps will insert a keyframe into the RTPC track, below
the RTPC clip. You can then use this Unity curve editor to add more
keyframes. The keyframes have a context menu that can be used for
more precise values.

i0Timeline
| Preview | 1 [ 1 | » | m1 [p | [[#][[#2 |[i0 ¢#| Timeline Demo ButtonTimeline (Button)

10 20 20 40 S0

@[ Cubenorth ]

Eecheso ] st R (TR
. oA cce|Eration

) ak RTPC Playable RTPC Value

Delete Key
Edit Key..

2 Clamped Auto
Aute

Free Smooth
Flat

Broken
Left Tangent

Right Tangent
Both Tangents




RTPC Keyframe Context Menu

10 Timeline
|P|‘eview [ et | 1 | > | i [om | [[»] [[a2 | |10 #| Timeline Demo ButtanTimeline (Button)

10 20 20 40 50

u‘CubeNor‘th
ElfScubeSouth | o
"None (Game Obje| @

["1 Ak RTPC Playable RTPC Value

Editting RTPC Keyframe Values
AkEventPlayable Clip Properties

The following properties are accessible from the inspector of an
AkEventPlayable clip:

¥ Ak Event Playable

Override Track Object: [«
Emitter Object Ref: ['Gameﬂhject | oo
Event: | PlayImpact |

AkEventPlayable Clip Properties

e Override Track Object: This can be checked in order to have the
Event emitted from a specific Game Object, different to the track
binding object. This will also override the Timeline owner object if the
track binding is set to None (see Ak Track Object Bindings).

e Emitter Object Ref: The Game Object from which the Event should
be emitted (only available when Override Track Object is checked).

e Event: The Wwise Event that will be triggered from this clip.



Known Issues & Limitations

Currently scrubbing is only supported in Play mode in the Unity editor.
This is due to an issue with Unity Playable callbacks in edit mode. Unity
are aware of the issue: 953109. This means that "Play from anywhere"
behavior is not supported in edit mode either. If you place the playhead
somewhere between the beginning and end of a clip and play the
timeline, while in edit mode, the event will not be triggered.


https://fogbugz.unity3d.com/default.asp?953109_kitf7pso0vmjm0m0

Wwise Project Setup

To ensure that Event lengths are properly represented in the AKEvent
Tracks, the Wwise project needs to be set up to estimate the duration of
its audio Events and JSON metadata must be generated. To enable
these project-wide settings, go to the Project Settings' SoundBanks tab.
Enable the Estimated duration check box within the Metadata Options
group box and enable the Generate JSON Metadata check box within
the SoundBank Settings group box, as seen below.



Motion Devices External Sources Metwark Custom Properties
General Sourc ings SoundBanks Logs Obstruction/Ocdusion
SoundBank Settings

Generate Bank Content TXT Files:  ANSI

Generate Metadata File Metadata Options:
|Use SoundBank names Generate Per Bank Metadata File Indude GUID
Generate header file Generate XML Metadata Max attenuation

Generate JSON Metadata Estimated duration

Allow SoundBanks to

SoundBank Paths

SoundBanksAndroid',
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Required Project Settings for AkEvent Tracks
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Unity

Unity Unity SoundBank Edit > Wwise
Settings... /

Wwise Project Path*:

Wwise Windows Installation Path:

SoundBanks Path* (relative to StreamingAssets folder):

W Enable copying of soundbanks at pre-Build step
W Enable soundbank generation at pre-Build step
& Create WwiseGlobal GameObject
[_|Aautomnatically add Listener to Main Camera

[ show Warning for Missing RigidBody




Wwise

Unity Wwise Profile Wwise
Assets > Wwise > Activate Plugins Wwise Release

Q Debug Audiokinetic

Android

iI0S

Linux

Unity Wwise



StreamingAssets

Unity Unity Assets StreamingAssets Unity
<UNITY_PROJECT_ROOT>\Assets\StreamingAssetsUnity Unity
StreamingAssets

SoundBanks Audio\GeneratedSoundBanks StreamingAssets

Unity Wwise Platform Manager
<UNITY_PROJECT_ROOT>\Assets\StreamingAssets\Audio\GeneratedSoundBank

<>

;] AkInitializer::basePath SoundBank

Unity SoundBanks Wwise GeneratedSoundBank
Wwise Project Settings Windows Mac bank


http://unity3d.com/support/documentation/Manual/StreamingAssets.html

SoundBanks

SoundBank StreamingAssets Wwise SoundBank
StreamingAssets SoundBank Wwise Settings
SoundBank



SoundBank

SoundBank StreamingAssets SoundBank
SoundBank

Wwise i0OS iPad iPhone Unity Wwise



SoundBank

Wwise SoundBank TXT XML SoundBank
StreamingAssets
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Android

APK Android SoundBank LoadBank() APl Unity

StreamingAssets SoundBank APK Assets Low-Level IO
APK SoundBank

Low-Level IO Android SoundBank SD

AkSoundEngine.AddBasePath() APK APK APK
DLC
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10S

IOS Unity Unity Editor Build Build Run Unity
Unity Xcode

UNITY_PROJECT_ROOT/Assets/Plugins/i0S

Unity thumb Xcode thumb



Wwise Integration 1ibAkSoundEngine.aiOSPlayer Settings
Other Settings Stripping Level 12 MB
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Linux

Linux Unity . Unity Editor Build Build Run
Unity Linux .x8632 .x86_6464

Wwise Unity Integration 1ibSDL2"DLLNotFoundException"

Ubuntu 12.04 1ibSDL2

&7

sudo apt-get install build-essential libasound2-dev
wget http://www.libsdl.org/release/SDL2-2.0.3.tar.gz
tar -zxvf SDL2-2.0.3.tar.gz

cd SDL2-2.0.3

./configure

make

sudo make install

sudo ldconfig

libsdl.org
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Unity Wwise
Wwise Unity Wwise C#

Q SoundBank GetPlatformName SoundBank



UNITY_PROJECT_ROOT/Assets/Wwise/Deployment/Components/AkBasePathGett
GetPlatformName() partial



IOS ipod iphone ipad

1. Wwise Platform Manager"iPod™iPhone"

"iPad" Wwise Platform Manager Wwise Helg
>

2. Unity C# AkBasePathGetter

public partial class AkBasePathGetter

{
#if UNTIY_IOS

static partial void GetCustomPlatformName(re
f string platformName)

{

(UnityEngine.i0S.Device.generation

{

n.iPodTouchl1Gen:

UnityEngine.i0S.DeviceGeneratio

UnityEngine.i0S.DeviceGeneratio
n.iPodTouch2Gen:

UnityEngine.i0S.DeviceGeneratio
n.iPodTouch3Gen:

UnityEngine.i0S.DeviceGeneratio
n.iPodTouch4Gen:

UnityEngine.i0S.DeviceGeneratio
n.iPodTouch5Gen:

UnityEngine.i0S.DeviceGeneratio
n.iPodTouchUnknown:

platformName = "iPod";

I/

UnityEngine.i0S.DeviceGeneratio
n.iPadlGen:

UnityEngine.i0S.DeviceGeneratio
n.iPad2Gen:


https://www.audiokinetic.com/library/?source=Help&id=managing_platforms

.1Pad3Gen:

.1PadMinilGen:

.1Pad4Gen:

.1PadAir1l:

.1PadMini2Gen:

.1PadMini3Gen:

.1PadAir2:

.1PadUnknown:

.1Phone:

.1Phone3G:

.1Phone3GS:

.1Phone4:

.1Phone4s:

.1Phone5:

.1Phone5C:

.1Phone5ssS:

.1Phoneé6:

UnityEngine.
UnityEngine.
UnityEngine.
UnityEngine.
UnityEngine.
UnityEngine.
UnityEngine.

UnityEngine.

platformName

I/

UnityEngine.
UnityEngine.
UnityEngine.
UnityEngine.
UnityEngine.
UnityEngine.
UnityEngine.
UnityEngine.

UnityEngine.

10S.

10S.

10S.

10S.

10S.

10S.

10S.

i0S

DeviceGeneratio

DeviceGeneratio

DeviceGeneratio

DeviceGeneratio

DeviceGeneratio

DeviceGeneratio

DeviceGeneratio

.DeviceGeneratio

= "iPad",

i0S

10S.

10S.

10S.

10S.

10S.

10S.

10S.

10S.

.DeviceGeneratio

DeviceGeneratio

DeviceGeneratio

DeviceGeneratio

DeviceGeneratio

DeviceGeneratio

DeviceGeneratio

DeviceGeneratio

DeviceGeneratio



UnityEngine.i0S.DeviceGeneratio
n.iPhone6Plus:

UnityEngine.i0S.DeviceGeneratio
n.iPhoneUnknown:

platformName = "iPhone";

I/

}
#endif

}

N platformName Unity

3. aC# AkBuildPreprocessorb C#
AkBuildPreprocessor

public class WwiseIOSBuildPreprocessor : IPrepro
cessBuild, IPostprocessBuild

{

public int callbackOrder { get { 0; }
}

string iPodDestinationSoundBankFolder = stri
ng.Empty;

string iPadDestinationSoundBankFolder = stri
ng.Empty;

string iPhoneDestinationSoundBankFolder st

ring.Empty;

public void OnPreprocessBuild(BuildTarget ta
rget, string path)

{
(target == BuildTarget.i0S)

{
AkBuildPreprocessor.CopySoundbanks(t
rue, "iPod", iPodDestinationSoundBankFolder);
AkBuildPreprocessor.CopySoundbanks(t
rue, "iPad", iPadDestinationSoundBankFolder);



AkBuildPreprocessor.CopySoundbanks(t
rue, "iPhone", iPhoneDestinationSoundBankFolder)

}

I/

}

public void OnPostprocessBuild(BuildTarget t
arget, string path)

{
DeleteSoundbanks(iPodDestinationSoundBan
kFolder);
DeleteSoundbanks(iPadDestinationSoundBan
kFolder);
DeleteSoundbanks(iPhoneDestinationSoundB
ankFolder);

4. Wwise "iPhone™iPod" "iPad" SoundBank
UNITY_PROJECT_ROOT/Assets/StreamingAssets/Audio/GeneratedSoundBe

5. Unity iOS
6. SoundBank
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Wwise Unity DLC

Wwise File Package

Wwise DLC Authoring Wwise Help > > File
Package > DLC BNK WEM DLC Wwise / Unity

Low-Level IO

Unity Base Path bank Aklnitializer
AkSoundEngine.LoadFilePackage()Wwise

Base Path iOS Android

Android iOS AkSoundEngine.LoadFilePackage()
AkSoundEngine.AddBasePath()

#1f UNITY_IPHONE
string fileNameBase = Application.dataPath.Subst

ring(0, Application.dataPath.LastIndexOf('/"));
fileName = fileNameBase.Substring(®, fileNameBas
e.LastIndexOf('/"')) + "/Documents/" + FILE_NAME;

#elif UNITY_ANDROID
fileName = Application.persistentDataPath + "/"

+ FILE_NAME :

#else
fileName = Application.dataPath + "/" + FILE_NAM

E;
#endif

Android SD

e OBB Android


https://www.audiokinetic.com/library/?source=Help&id=dlc_overview

Unity WWW

Unity WWW DLC bank AkMemBankLoader.cs
bank bank bankWwise 10
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Wwise-Unity C# Wwise API C++
C++



N =

roONPE

Wwise Launcher Wwise SDK
Windows Mac Wwise Launcher Unity
_Src.zip

Windows Mac

Unity
Integrated Development Environment (IDE)
Deployment API






e Unity 5 (Personal Pro)
e Wwise SDK

e Python 2.7.x 3.xPython

Android SDK 32 API 9 64 API
21..

Mac Wwise SDK WWISESDK

e Cygwin (Windows )

e Android NDK r10e.
e Apache Ant 1.8.4.
Android ° W".Vise SDK
e Unity
[ ]
o CYGWIN_HOME Cygwin (Windows )
o ANDROID_HOME Android SDK
o ANDROID_NDK_ROOT Android NDK
o ANT_HOME Apache Ant
i0S | e Xcode 7.2
e iOS Wwise SDK WWISESDK
o ( sudo apt-get install build-essential)
Linux e SDL2 ( Linux SDL2)
e Linux Wwise SDK WWISESDK
Mac | e Xcode 7.2
1

e SDK Wwise SDK R¢




PS4 ||Visua| Studio 2012
Windows ||Visua| Studio 2013
Windows Visual Studio 2015.
Store

Xbox One

||Visua| Studio 2012




Wwise SDK Unity Assets Wwise
Unity .unitypackage Assets



e StreamingAssets SoundBank
e Wwise
o Deployment

APIC++ C# Wwise SDK
Dependencies Unity
Components Unity
Plug-ins/b> Unity

]
Platform

= Architecture

= Debug Wwise

= Profile Wwise
= Release Wwise
= DSPWwise

o EditorWwiseUnityIntegratio Inspector
e Tools



o Wwise
o AkSoundEngine IDE
= Common
= Platform IDE
o Integration/Assets/Wwise/Deployment
= APIAPI
= Generated SWIG API
= Handwritten API
= Components Unity
= Plugins Wwise AkSoundEngine
= <platform>
= <architecture>



Wwise\AkSoundEngine\Common\BuildWwiseUnityIntegration.py

python BuildwWwiseUnityIntegration.py -h



Integrated Development Environment (IDE)
Wwise Unity Integration

WwiseUnityIntegration_version_platform_Src.zip\Wwise
\AkSoundEngine\YourPlatform

Xcode IDE

Xcode Mac iOS

WWISESDK Xcode $WWISESDK -w Xcode IDE
WWISESDK Mac iOS Xcode
AkSoundEngine{platform} Build Settings
User-Defined WwISESDK ex: [Users/ImyUser/Wwise/SDK

Linux

Linux

® cd <Integration source location>/AkSoundEngine/Common
® . /premaked4 --akplatform=Linux gmake
® make -f AkSoundEnginelLinux.make config=<config>

<config> debug32profile32release32debug64 profile64
release64 <Integration source location>/Deployment/Plugins/Linux



Wwise\Deployment\Plugins\[Platform] Assets\Wwise
Assets



SWIG Wwise SDK Unity APl SWIG Unity
Wwise Wwise for Unity APl SWIG C++

1. Wwise SDK Unity Windows .dll Mac OS X
.bundle iOS .a Android .so Deployment
Unity

e C++ Wwise |/
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Unity Editor

UNITY_PROJECT_ROOT\Assets\Wwise\Logs\BuildWwiseUnity
Integration.log

():

2013-09-26 09:29:56,490: INFO: BuildwWwiseUnityIntegr
ation.py (WindowsBuilder): 91: Building: Windows (Wi
n32, Debug)

Wwise Unity Buildutil.CreatelLogger ()

WwiseUnityIntegration_version_platform_Src.zip\Wwise
\AkSoundEngine\Common\AkSoundEngine\Common\BuildUtil

- Py

Python logging.handlers

IDE Visual Studio IDE
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C++ Wwise |

. e Unity Unity
P e Unity check-out Unity

o Wwise Unity

Wwise Unity Wwise  Unity Wwise
Launcher Wwise

Wwise Wwise

-

3 Wwise Unity



Unity Wwise

Wwise Launcher Unity Wwise



Wwise

1. Wwise Unity Wwise

o Wwise

1. Wwise “Yes”

2. Unity Wwise SoundBank

3. SoundBank Unity StreamingAssets



C++

1. Wwise SDK
2. Unity Unity
3. Unity

4. Unity

5.
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API

Wwise SDK Unity

® UnloadBank()

IOS API

AK: :SoundEngine: :i0S::ListenToAudioSessionInterruption()

e Windows GetGameObjectFromPlayingID() Windows 32 64
32 GameObiject ID

e postEvent() GameObject API null GameObiject

® PostEvent()

® AK::Monitoring::SetLocalOutput()
AkCallbackManager .SetMonitoringCallback()

® AK::SoundEngine: :SetPosition()
AkSoundEngine.SetObjectPosition()

® PostEvent()

e  AK::SoundEngine::DynamicSequence APl Unity API
SWIG API
AK: :SoundEngine: :DynamicSequence: :0pen()
AkSoundEngine.Open() API
AkSoundEngine.DynamicSequenceOpen()
e C++ Unity AkArray::operator[]
AkPlaylistArray.ItemAtIndex(uint uiIndex) SWIG C++

[ ]
>
9

IOS API

AkSpeakerVolumeMatrixCallbackInfo
AkSpeakerVolumeMatrixBusCallbackInfo
AkBusCallbackFunc

AK: :SoundEngine: :RegisterBusVolumeCallback
AK: :SoundEngine: :RegisterCodec

AK: :SoundEngine: :RegisterGlobalCallback
AK: :SoundEngine: :RegisterPlugin

AK: :SoundEngine: :Query: :AkGameObjectsList
AK: :SoundEngine: :Query: :GetActiveGameObjects()
AK: :SoundEngine: :Query: :GameObjDst

AK: :SoundEngine: :Query: :AkRadiusList

0O 0O O 0O O 0O 0O 0O O 0o 0o o



o0 AK::SoundEngine::Query::GetMaxRadius(AkRadiusList&
io_RadiusList)

o Event
AK: :SoundEngine: :DynamicDialogue: :ResolveDialogueEvent
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Android

Android

Android

OBB Android
Wwise Unity DLC



10S

e IOS
e iIOS
e Wwise Unity DLC



Linux

e Linux



Windows Store Apps

e Windows Store Apps
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Android

AkSoundEngine.Suspend() AkSoundEngine.WakeupFromSuspend()
Aklnitializer
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OBB Android
OBB Wwise IO

Android Unity Player Settings > Publishing Settings >
Split Application Binary  APK Expansion Files .obb zip
StreamingAssets SoundBank Android SoundBank

SoundBank APK OBB

OBB AkSoundEngine.SetBasePath OBB OBB
/O OBB CPU


http://developer.android.com/google/play/expansion-files.html

SoundBank

in-memory bank AkMemBankLoader.cs SoundBank

1. SoundBank

2. Inspector SoundBank < b>Bank name

3. Inspector SoundBank Is Localized Bank
AkInitializer.cs

4. SoundBank

AkMemBankLoader .LoadNonLocalizedBank() AkMemBankLoader
SoundBank LoadLocalizedBank ()



e in-memory SoundBank low-level IO zip
SoundBank streamingmanager_lowlevel

e SoundBank SoundBank

e in-memory SoundBank-loading APl API
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10S
Unity Integration

® AkAudioSessionCategorySoloAmbientiPhone Ring/Silent

e AkAudioSessionCategoryAmbient: AmbientSound Music
BGM Ul
AkCallbackManager .SetBGMCallback()

SoloAmbient BGM Ambient BGM
BGM

I0OS Suspend
WakeupFromSuspend
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Windows Store Apps

e Universal Windows Platform Windows SoundBank SDK
SoundBank
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Wwise Demo Game

Demonstration scenes, containing the Wwise Unity Integration, are
available to download from the Wwise Launcher Unity page under the
contextual menu in the "Recent Unity Projects" title. Unity



The Wwise Demo Game is a standalone project. Wwise Launcher
Wwise Launcher Wwise Unity

e The generated SoundBanks are included in the package.
™ e You can find the Wwise Project associated with the scenes
~ under <DEMO_SCENE_ROOT>/WwiseProject. Leaving the Wwise
project in the game's Assets folder is not recommended, but it
was necessary in this Demo for packaging purposes.



The Wwise Demo Game is intended as a way to preview and show how
the Wwise Unity Integration can be used in the Unity Editor.

To deploy one of the Wwise Demo Game scenes to a game console or
mobile device, follow these steps:

1. Within the Launcher's Unity tab, select the Modify Wwise in

Project... option from your Wwise Demo Game Unity Project.
1. Launcher Unity

2. Deployment Platforms Modify

3. Unity

4. SoundBank

5. Copy the Generated SoundBanks folder to the
StreamingAssets/Audio folder.

6. Unity



First-Person 3D "'For each station, there is a small description
on a sign next to the station.

Wwise Random container Switch Container
Footstep Footstep_material

Box Collider Switch Value Wwise Picker Window Box
Collider Footstep_Material First Person Controller
"AkTriggerEnter" Ak Switch "Use Other Object"

Inspector Window

0.3 Footstep First Person Controller Wwise
SoundEngine

Unity

AkTriggerButtonPress AkTriggerBase
triggerDelegate AkTriggerBase Wwise Component Inspector
" Ak Ambient

WAV marker marker Ak Ambient inspector

"Use Callback” GameObject SubtitleSign

SubtitleDemo.cs "Game Object" Callback

Function MarkercCallback Callback Flag "Marker"

Subtitlebemo Callback MarkerCallback ulIdentifier
inspector AkAmbient



EnvironmentZone Box Collider AuxBus Wwise
Picker

Wwise Auxiliary Bus Little Sequence "Use game-
defined Auxiliary sends"

Wwise EnvironmentZone AuxBus

Environment Portal Environment Portal Auxiliary Bus

Box Collider Ak Environment "z" Ak
Environment Portal

Environments Environment Portal inspector
AKEvironment AkEvironmentPortal

Timeline Demo

This station demonstrates the use of an AkEventTrack and an
AKRTPCTrack within a Timeline in Unity. There are two cubes, which,
when the button is pressed, are animated towards each other and
stopped when they reach impact.

In order to inspect the Timeline, select Window->Timeline. Then in the
Hierarchy, expand the TimelineDemo object, and then expand the
Timeline Demo Button object. Then select the Button object. The
Timeline editor will now show the Timeline that controls the animation
and Wwise Events for the cubes. The Timeline is controlled by the
Playable Director component of the Button object.

The Timeline contains two animation tracks, one for each cube. These
tracks are used to animate the z position of each cube over time. The
Timeline also contains an AkEventTrack and an AKRTPCTrack, marked
by a white and red tab, respectively. The AkEventTrack contains two
AkEventPlayable clips: the first triggers the PlayCubeMovement Wwise
Event, and the next triggers the Playlmpact Wwise Event. The nhames of
these Wwise Events are displayed in the clips. You may need to increase
the size of the Timeline editor view and zoom in in order for the name to



be displayed correctly. The PlayCubeMovement Wwise Event plays a
sine wave source, which has an RTPC affecting its pitch. The name of
this RTPC is CubeAcceleration. The AKRTPCTrack increases this RTPC
over time as the cubes move towards each other. This causes the pitch
of the sine wave to increase, producing a simple sound effect to indicate
the acceleration of each cube towards the other.

This station also demonstrates the Motion feature. Note that there is a
game object called "Motion listener” in the player hierarchy. This game
object set up the output for the Motion device on supported platforms.
Any output needs a set of listeners to receive data. That is why the
Motion listener also have a Ak Game Object and a Ak Audio Listener. To
enable the Motion effect on the cube impact, two important things needs
to be done. First, the impact sound needs to be routed to an output bus
using the Wwise Motion ShareSet in the Wwise project. Second, the
listener used for the Motion output needs to be added to the listeners of
the emitter posting the impact event. Inspect the AkMotionListener script
for an example on how to add an output.

To support the Motion feature on android, the manifest of the
.. application must include the vibration permission. Unity generates
| automatically the manifest based on the content of the application.
Adding a call to Handheld.vibrate() will add the desired permission
in the manifest.

For more information on the Timeline integration, see Wwise Timeline
Integration.



Spatial Audio Scene

This scene is the final product of the Spatial Audio Tutorial.
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Using Wwise Spatial Audio in Unity

This chapter gives an overview of how to use the Spatial Audio features
of the Unity integration. It is broken down into:

e A preparation page you need to follow before going to the tutorials:
o Preparation for the Spatial Audio Tutorials
= 1. Create a Unity Project
= 2. Wwise Project Preparation
= 3. Unity Project Preparation
e Two independent tutorials:
o Surface Reflectors Tutorial
o Rooms and Portals Tutorial
¢ And a supplementary page addressing the use of obstruction and
occlusion:
o Obstruction and Occlusion

Completion of sections using the Wwise Reflect plug-in require
the appropriate license.
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Preparation for the Spatial Audio Tutorials

The following steps must be followed beforehand to successfully
complete the Surface Reflectors Tutorial and the Rooms and Portals

Tutorial :

¢ 1. Create a Unity Project
e 2. Wwise Project Preparation
¢ 3. Unity Project Preparation
o 3.A. Environment
o 3.B. Character Listener
o 3.C. Third-Person Emitters
o 3.D. Scene



1. Create a Unity Project

Using the latest version of Wwise and Unity, follow the steps below in
order to build your working environment.

. Launch Unity and create a new project.

1
2. Close Unity.
3. Start the Wwise Launcher and integrate Wwise into your Unity

project.


https://www.audiokinetic.com/library/edge/?source=InstallGuide&id=integrating_wwise_into_an_unreal_or_unity_project

2. Wwise Project Preparation

For the tutorials, you will need a Sound SFX, an Event to play it, and a
SoundBank.

1. From the Launcher, open your project in Wwise.
2. Add a Sound SFX under the Actor Mixer Hierarchy's Default Work
Unit. In the integration Wwise Project, we added a dialogue.
1. Import a sound into it.
2. In the Sound Property Editor's
1. General Settings tab, enable Use game-defined auxiliary
sends.

APNP 21X
M 5 Aofes
Mame Diglogue
I General Settings = Source Settings  Effects  Posiioning RTPC  States

Voice Output Bus

User-Defined Auxliary Sends

ID | Auxiliary Bus

0
1
3

Sound Property Editor General Settings tab

2. Positioning tab, enable positioning and choose 3D.
Optionally, add an Attenuation.



Indusion M S Notes
Mame Diglogue

General Settings  Source Settings  Effects  Posiioning RTPC  States  Advanced Settings

Center % || 1]

Enable Positioning: {]| 3D

2D 30
Attenuation

Mode  Define custom

Sound Property Editor Positioning tab

Right-click on the Sound SFX within the Actor-Mixer Hierarchy, then
select New Event > Play.

Name: PlayDislogue

Event Editor

. Go to the SoundBank layout (shortcut F7) and add a new
SoundBank. Drag the Event into the new SoundBank. Here's how
the SoundBank Manager should look in the integration Wwise
Project:



1) Default Work Unit
&/ Environments
B Footsteps
8 Spatialaudio

2017-10-23 7

WitaHW
WitaSW
Windows

oundBank Editor
Mame
Spatial Audio
Edit Details

ult Work Unit\PlayDialogue®

Manually added

SoundBank Manager and Editor

5. Save your project.



3. Unity Project Preparation

In this section we will create our game area and the objects in it. We will
need a listener, emitters, and two rooms. From the Launcher, open your
project in Unity. Open the Wwise Picker (Windows > Wwise Picker),
Refresh Project, and Generate SoundBanks.

3 Project El Console | Wwise Picker |

||Eﬁ.utu populate [ Refresh Project H Generate SoundBanks ]|

| G

B

wiseProject
Events

Switches

States
SoundBanks
Auxiliary Busses
Virtual Acoustics

ol | [
[ ][] [ [ [ |+g:

[?[?[?[?[?E” 5

Wwise Picker
3.A. Environment

1. Create a floor, walls, and ceilings using cubes: GameObject > 3D
Object > Cube.

Object Name Position Rotation Scale
Floor (0, 0, 0) (0,0,0) (50, 0.5, 50)
Wall Front Left (-4.5, 3, -10) (0, 0, 0) (7, 6, 0.5)
Wall Front Middle | (0, 5, -10) (0, 0, 0) (2, 2,0.5)
Wall Front Right | (2.5, 3, -10) (0, 0, 0) (3, 6, 0.5)




Wall Left Small (-7.75, 3, -6) (0, 0, 0) (0.5, 6, 8)
Wall Back Small | (-2, 3, -2) (0, 0, 0) (12, 6, 0.5)
Ceiling Small (-2, 5.75, -6) (0, 0, 0) (12, 0.5, 8)
Wall Right Small | (3.75, 3, -8) (0, 0, 0) (0.5, 6, 3.5)
Wall Front Large | (11.5, 3, -7.5) (0, 0, 0) (16, 6, 0.5)
Wall Right Large | (19.25, 3, 3.25) | (0, 0, 0) (0.5, 6, 21.5)
Wall Middle (3.75, 5, -4.5) (0, 0, 0) (0.5, 2, 3.5)
Wall Left Large (3.75, 3,5.625) |(0,0,0) (0.5, 6, 16.75)
Wall Back Large | (11.5, 3, 14) (0, 0, 0) (16, 6, 0.5)
Ceiling Large (11.5, 5.75, 3.25) | (0, 0, 0) (16, 0.5, 22)
Barrier (-4.5, 3, -17) (0, 0, 0) (7, 6, 0.5)

2. Add spotlights inside rooms ( GameObject > Light > Spotlight ).

Object Name Position Rotation Scale
Spotlight Small Room | (-3, 5.75, -6) | (0, 0, 0) (1,1,1)
Spotlight Large Room | (11.5, 5.75, 5) | (0, 0, 0) (1,1,1)

1. In the Light component, change:
1. Range to 30.
2. Spot Angle to 179.

Object Name Position

3.B. Character Listener

1. Create a character with the method of your choice.
Rotation

Scale

MainCharacter

(0, 1.3, -20) | (0, 0, 0)

(1,1,1)

1. Remove any Unity Audio Source.
2. Add an Ak Audio Listener component to the camera.

Ak Audio Listener component

3. Add an Ak Spatial Audio Listener component to the camera.




‘F@ [+ Ak Spatial Audio Listener (Script) ,

1 The current version of Spatial Audio only supports one listener, Make sure to
=y, only have ane AkSpatialAudioListener active at a time.

Ak Spatial Audio Listener component

3.C. Third-Person Emitters

1. Create buttons using cylinders ( GameObject > 3D Object >
Cylinder ).

Object Name Position Rotation Scale
Button Outside (-3, 0.75, -15) | (0, 0, 0) (0.15, 0.5, 0.15)

Button Small Room | (-3, 0.75, -5) | (0, 0, 0) (0.15, 0.5, 0.15)

Button Large Room | (7.5, 0.75,5) | (0, 0, 0) (0.15, 0.5, 0.15)

2. Add an Ak Spatial Audio Emitter component.

¥ || [+ Ak Spatial Audio Emitter (Script) #*,
Script AlkSpatialdudioEmitter o]

Early Reflections
Reflect Aux Bus [ Mo AuxBus is currently selected

Reflections Qrder ', 1
Reflections Aux Bus Gain ) |1
Reflection Max Fath Length 1000

Rooms
Room Reverb Aux Bus Gain ) |1

Debug Draw
Draw First Order Reflections

Draw Second Order Reflections
Draw Higher Order Reflections

ooog

Draw Sound Propagation

Ak Spatial Audio Emitter component

3. Inthe Ak Game Obj component:
1. Enable the Environment Aware option.
2. Enable the Use Default Listener option.



Apply Position Offset: -
Environment Aware: [

Interactions between AkGameObj and AkEnvironment or AkRoom require a

Rigidbody compaonent on the object ar the environment/room.

Add Rigidbody

| Initial Listener List [ Use Default Listeners

1l Add Listener

Ak Game Obj component

4. Add an Ak Ambient component:

1. Choose your preferred way to start the sound in Trigger On.
2. Choose the Play_sound Event in Event Name.

Ak Ambient component

5. Add an Ak Bank component:
1. Add the SoundBank created in 2. Wwise Project Preparation
to Bank Name.

Load On:

Unload On:

Asynchronous:

Decode compressed data:

Bank Mame:

Ak Bank component



6. Start the game, connect it to Wwise, and open the Profiler layout
(shortcut F6).

7. Play the sound from a button. You should hear the sound you
imported in the Wwise project.

8. In the Voices Graph tab, you should see the following graph.
Advanced Profiler
Voices Graph ~ Voices Busses Sends  Emitter-listener Memory Streams  Streaming Devices  Plug-ns  Obs/Occ
Filter: | Flter Reset View: >
N
Button Outside Voice Graph with no Effect
3.D. Scene

1. Save your Scene to a convenient place.

2. The final look of the scene is shown in the following image. This
scene is available with the Unity integration package. Colors were
added to elements of the scene for convenience. A mobile first-
person controller was also added.



Tutorial Unity Scene
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Surface Reflectors Tutorial

In the following steps, this tutorial will show you how to use the new
Reflect plug-in with Spatial Audio. You will need a Reflect plug-in license
to make the project work.

e A. Wwise Project
o B. Spatial Audio Emitter
o C. Surface Reflector Component
o C.1. Use Existing Meshes
o C.2. Alternative: Create a New Volume

Note: This tutorial presumes that you have completed the Preparation
for the Spatial Audio Tutorials. However, it does not consider if the
Rooms and Portals Tutorial was done; both tutorials are independent.



A. Wwise Project

We need to update our wwise project with an Auxiliary Bus with the
Reflect plug-in and Acoustic Textures.

1. Add an Auxiliary Bus under the Master Audio Bus.
1. In the Auxiliary Bus Property Editor,
1. Under the Effects tab, add the Wwise Reflect effect.

K ThirdPerson - Auxiiary Bus Property Editor [Z)
M s

Name ThirdPerson

General Settings  Effects  Positioning RTPC  States  +

MName Prev. |Next | Mode Bypass
ThirdPerson < = Use ShareSets Bl

Auxiliary Bus Property Editor Effects tab for Reflect

2. Under the Positioning tab, enable positioning and choose
2D.



K3 ThirdPerson - Auxiliary Bus Property Editor [Z ]
M s
MName ThirdPerson

General Settings  Effects  Positioning  RTPC  States

Center % (]| 100

Enable Positioning: |[| 2D

2D

Enable Panner

Auxiliary Bus Property Editor Positioning tab for
Reflect

2. Import Reflect Acoustic Textures from: Project > Import Factory
Assets...
1. They will be added to the Virtual Acoustics folder in the
ShareSets tab of the Project Explorer view.



Project Explorer S

| Events SoundBanks GameSyncs ShareSets  Sessions  Queries (KNI

Effects
Attenuations
Conversion Settings
Modulators
Audio Devices
Virtual Acoustics
M Default Work Unit
M Factory Reflect Acoustic Textures
= 8 Textures
il Acoustic_Banner
mil Anechoic
il Brick
i Carpet

nEEEE s

L EOnErets
iy Cork_Tiles
il Curtains

il E'F}".a'-.'ﬁ"

. Fabric

il Mountain
il Tile

Ll Wood

i Wood_Bright

il Wood_Deep

Factory Reflect Acoustic Textures in the Project Explorer
ShareSets tab

2. (optional) You can add custom Acoustic Textures in the Virtual
Acoustics folder under Default Work Unit.
3. Save your project.



B. Spatial Audio Emitter

We need to modify the spatial audio emitter to use our newly created
reflect aux bus.

1. Refresh your Wwise project in the Wwise Picker: Windows > Wwise
Picker

1. Generate SoundBanks
3 Project El Console | Wwise Picker |

|Iz.ﬁ.utu populate [ Refresh Project H Generate SoundBanks ]|

a
A

B

= q WwiseProject

. =-{JEvents

- @ ] Switches

*FD States

- =4 ] SoundBanks

- = ] Auxiliary Busses
- = ] Virtual Acoustics

Wwise Picker

2. Modify the Ak Spatial Audio Emitter component of each button.
Pick the Reflect Auxiliary Bus for Reflect Aux Bus.

Choose 2 for the Reflections Order.

Choose 1 for the Reflections Aux Bus Gain.

Choose 100000 for the Reflection Max Path Length.
Check the Draw First Order Reflections and Draw Second
Order Reflections under Debug Draw.

abhowbdpE



Ak Spatial Audio Emitter for Surface Reflector



C. Surface Reflector Component

You can simulate early reflections with the Ak Surface Reflector
component. One way to have surface reflectors is to use existing meshes
of the game. If the shape is too complex, you may want to add a new
object as a surface reflector.

C.1. Use Existing Meshes

The advantages of using the existing meshes are that you don't need to
create new objects and each mesh can have a different acoustic texture.
The disadvantages are that if you have a complex figure, you may send
too much triangles to the Spatial Audio APl and this could slow down
your game. Also, another disadvantage is that each mesh only gets
assigned one texture. In the case of the this tutorial, this means that it is
not possible to have a different acoustic texture on the outside than on
the inside of the rooms. In the scene provided by the unity integration,
this is the method used for surface reflectors.

1. Select all the walls, ceiling and floor from section 3.A. Environment
and add an Ak Surface Reflector component.
1. In the Acoustic Texture parameter, choose an acoustic texture
or leave it at None to have an unfiltered reflection.

¥ @ [ Ak Surface Reflector (Script) ﬁ i,
Script AlkSurfaceReflectar @

Acoustic Texture [Nnne |

Ak Surface Reflector component

2. Start the game.

1. Since we have enabled the drawing of reflections under Debug
Draw in section , you should see rays going from the emitter to
the listener in the Scene window. (The ceiling was removed in
the following image to see the rays clearly) The blue rays are
first order reflections, i.e. they reflect from one surface before
reaching the listener, and the yellow rays are second order
reflections. The name of the triangles are displayed at the
reflection point. A name is made up of the game object's name



and the triangle's number. A cube has 12 triangles, two per face.

Front Middle &

Top view of early reflection drawings for existing mesh
surface reflectors

2. You can see the rays in the Game window by enabling Gizmos;
as we can see in the next image. From this point of view, we can
also see that the Debug Draw option draws the triangles of the
surfaces that are being reflected on. Leaving the ceiling in this
view, we can see that the sound will also reflect from the ceiling
on triangles 7 and 6.



Wall Back_4

!
Wallheack_4a

Wall Back_4

Wall Front Left_0

First person view of early reflection drawings for existing
mesh surface reflectors

3. Connect the game in Wwise and go to the Profiler Layout. You

oices  Busses Sends Emitter-listener Memory Streams  Streaming Devices  Plug-ns  Listenes

Filter: v Filter Reset Vi

N




Button Small Room Voice Graph with Reflect Effect

4. Double click on the Auxiliary Bus with the Reflect Effect in the
graph. Navigate to the Effects tab and double click on the
Reflect Effect. When playing the sound, you should see the
current reflections in the graph and the list of the Reflect Effect
Editor. In thw following image, there is a Drywall acoustic texture
for all the walls and the ceiling and a Tile acoustic texture for the
floor. When there are two textures in the list, it means that the
reflection is a second order one.

ThirdPerson - Effect Editor

Drywall, Drywal
on  Tile, Drywall

Drywall, Drywal

;
on  Drywall, Drywall

5 Wall FrontLeft_1 3utton  Tile, Drywall
M 5 WallFrontLeft_1 Button Drywal, Drywal

Reflect Effect Editor View

C.2. Alternative: Create a New Volume

Creating a new game object with no mesh renderer can simplify a
complex shape. In this optional section, we will show you how to have a
surface reflector volume for the interior of the small room. You can also
mix solutions by having some meshes be Surface Reflectors and having
an object with no mesh renderer as well. Having each mesh be a
surface reflector to have different texture per wall inside of the house and



adding and exterior volume to have a completly different texture on the
outside of the house. It is also possible to use Quads instead of cubes to
have a different texture wherever desired. But be careful with
intersections when using quads; you don't want your sound to get out of
your shape.

1.

Create a simpler unrendered mesh using a cube: GameObject > 3D
Object > Cube

Object Name Position Rotation Scale

Small Room Interior | (-2, 2.875, -6) | (0, 0, 0) (11, 5.25, 7.5)

1. Remove the Mesh Renderer component
2.
3. add an Ak Surface Reflector.

Check the Is Trigger in the Box Collider component

Start the game.

1.

Since we simplified the shape of our room, the door is now part of
the reflective surface. We don't have any reflections from Button
Small Room if we are standing outside. We even get a reflection
from Button Outside on the door opening. You may have noticed the
name of the reflection point is now referencing to Small Room
Interior.



Top view of early reflection drawings for a new surface reflector
volume when the emitter is outside

2. Entering the small room, Button Small Room's debug drawings
appear and the ones for Button Outside disappear.



=mall Roomn Interior_11

=mall Room Interior_11

5 W TR 1

[T

~ % ~, oy
SmalE Fread k. S isit et Tat e tedim I R

Top view of early reflection drawings for a new surface reflector
volume when the emitter is inside
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Rooms and Portals Tutorial

This tutorial will show you how to use Rooms and Portals with Spatial
Audio. The following sections detail each step in the tutorial:

A. Wwise Project

B. Spatial Audio Emitter

C. Rooms

D. Portals

E. Portals and Reverb

F. Surface Reflectors and Reverb

Note: This tutorial presumes that you have completed the Preparation
for the Spatial Audio Tutorials. However, it does not consider if the
Surface Reflectors Tutorial was done; both tutorials are independent. If
you did the Surface Reflectors Tutorial and wish to continue with this
tutorial, you can do so without changing anything to your scene except
for the optional step of C.2. Alternative: Create a New Volume, which
should be reverted. If you wish to start anew, and you've done the
Surface Reflectors Tutorial, you can still keep the same scene and just
remove any Ak Surface Reflector components.



A. Wwise Project

For the rooms and portals tutorial, we will need to add Reverb Effects
and modify Obstruction curves to hear diffraction through a portal when
loosing sight of an emitter.

1. Add two Auxiliary Busses under the Master Audio Bus called
SmallRoom and LargeRoom. In the Auxiliary Bus Property Editor,
1. Under the Effects tab, add the Wwise RoomVerb effect. | chose
two different factory presets: Rooms/Room_Medium for

SmallRoom and Cathedrals/Medium for LargeRoom.
L3 LargeRoom - Auxiliary Bus Property Editor [7//X

Mame LargeRoom

General Settings Effects  Positioning RTPC  States  +

Mame Prev, |Mext |Mode
Cathedrals{Medium < = Use ShareSets G

Auxiliary Bus Property Editor Effects tab for rooms

2. Under the Positioning tab, enable positioning and choose 3D.



%= LargeRoom - Auxiliary Bus Property Editor

Mame LargeRoom
General Settings Effects  Positoning RTPC  States

Center % |]| 100

Enable Positioning: |[| 3D

2D
Attenuation

Mode  Use ShareSets

Position Source

User-defined

Game-defined

Update at each frame

Spatizlization Mode  Position + Orientation

Auxiliary Bus Property Editor Positioning tab for rooms

2. Project > Project Settings > Obstruction/Occlusion
1. Change the curves:

Point 1
X Iy
|Obstruction Volume ||0 ||0
[Obstruction LPF lo lo
2. Here's how the Obstruction Volume curve looks like:

Curve




Motion Devices External Sources Metwork Custom

General Source Settings SoundBanks Logs Obstruction/Ocdusi

Windows
jonOcdusion
Notes:

Cbstruction Volume
Obstruction LPF
Obstruction HPF
Ocdusion Volume
Ocdusion LPF
Ocdusion HPF

Coordinates

Cancel

Obstruction/Occlusion curves in the Wwise Project Settings

3. Save your project.



B. Spatial Audio Emitter

We need to modify the spatial audio emitter to use our newly created
reflect aux bus.

1. Refresh your Wwise project in the Wwise Picker: Windows > Wwise
Picker

1. Generate SoundBanks
3 Project El Console | Wwise Picker |

||E.ﬁ.utu populate [ Refresh Project H Generate SoundBanks ]|

| G

B

wiseProject
Events

Switches

States
SoundBanks
Auxiliary Busses
Virtual Acoustics

| #
[ ][] [ [ [ |+ﬂ

[?[?[?[?[?E” 5

Wwise Picker

2. Modify the Ak Spatial Audio Emitter component of each button.
1. Apply a gain of 1 for the Room Reverb Aux Bus Gain
parameter.

2. Check Draw Sound Propagation under Debug Draw and
uncheck all the others.



v || [+ Ak Spatial Audio Emitter (Script) ,

Script AlkSpatialdudioEmitter @
Early Reflections

Reflect Aux Bus [ Mo AuxBus is currently selected |
Reflections Order - 1 [
Reflections Aux Bus Gain ) |1

Reflection Max Fath Length 100000

Rooms
Room Reverb Aux Bus Gain |1

Debug Draw

Draw First Order Reflections [
Draw Second Order Reflections ||
Draw Higher Order Reflections ||
Draw Sound Propagation [

Ak Spatial Audio Emitter for Rooms and Portals

3. We will use rooms in the next section, so we need to add a
Rigidbody component to our emitter; as explained in the warning
message on the Ak Game Obj component.

1. Click on Add Rigidbody

7 ||+ Ak Game 0bj (Script) *,
|App|'gr Position Offset: -
| Environment Aware: [ |

Interactions between AkGameObj and AkEnvironment or AkRoom require a
Rigidbody compaonent on the object ar the environment/room.

( Add Rigidbody |

Initial Listener List [ Use Default Listeners
[ Add Listener ]

Ak Game Obj component




C. Rooms

Each of the rooms will have their own room reverb. To do so, we will use
the Ak Room component.

1. Create unrendered meshes using cubes: GameObject > 3D Object >
Cube

| Object Name || Position || Rotation
|Sma|| Room Interior ||(—2, 2.875, -6) ||(O, 0, 0)
|Large Room Interior ||(11.5, 2.875, 3.25) ||(O, 0, 0)

1. Remove the Mesh Renderer component.
2. Check the Is Trigger in the Box Collider component.
3. Add an Ak Room component to the Small and Large Room
Interior Volumes.
1. Pick the corresponding SmallRoom or LargeRoom Auxiliary
Busses for Reverb Aux Bus.
2. If you added a Rigidbody to your emitters, you don't need
one here. If not, click on Add Rigidbody.
¥ @ [+ Ak Room (Script) ﬁ i,
Reverb Aux Bus | SmallRoom |
Reverb Level O |1

Wall Occlusion O |1

Priority ]

Interactions between AkGameObj and AkEnvironment or AkRoom require a
Rigidbody companent on the object ar the environment/room.

[ Add Rigidbody ]

Ak Room component

2. Start the game, connect to Wwise and go to the Game Object
Profiler layout

1. Watch all the emitters and the listener.

2. Open a Game Object 3D Viewer view. You should see each
emitter in their respective rooms. The next image is a top view
of the scene. The listener and Button Outside are not in a room,
so they are put by default in the "Outdoors" room. If everything
is in the Outdoors room instead of their respective rooms, it
means spatial audio is disabled. You must have forgotten to add



an Ak Spatial Audio Listener component to the listener. Follow
step 3.B.

Game Object 3D Viewer

Locate Object > i__ | Follow

Room Inkerior

Emitters in their respective rooms and the Listener
Outdoors

3. Move the listener to a room and see the room name change
under your listener game object in the Game Object 3d Viewer.
In the following image, the listener is in the large room.



Game Object 3D Viewer

Locate Object > | 1 Follow

nterion

Emitters in their respective rooms and the Listener in the
Large Room Interior

3. Press the button in one of the rooms to hear the reverb.
1. In the small room, the voice graph should look like this:



Advanced Profiler

Voices Graph  Voices Busses Sends  Emitter-listener Memory Streams  Streaming Devices  Plugdns  Obs/Oc

Filter: e Filter Reset

N

Button Small Room Voice Graph with Reverb

2. When a listener is in a different room than the emitter, the sound
is completely occluded. You will need to add portals to hear the
sound coming from rooms through desired openings.

To add a reverb outside, add a Room around the entire area.

Make sure that the Room has a lower priority than the Small Room
Interior and Large Room Interior.



D. Portals

Each Room needs a Portal to be connected to another area. We need
two Portals: one on the door between the outside area and the small
Room and one between both Rooms.

1. Create two Ak Room Portal components: GameObject > Wwise >

Room Portal

| Object Name || Position || Rotation
[Outside Portal I, 2, -10) |0, 0,0)
|Inside Portal ||(3.75, 2, -4.5) ||(O, 90, 0)

2. In the Ak Room Portal component:
1. Open On Start.
2. Close On Nothing.
3. Make sure that the Back Room and Front Room display the right
Ak Room components.
3. This is how the Inside Portal Ak Room Portal component will look

like:
7 || [+ Ak Room Portal (Script) [ #
| Open On: | Start *||
| Close On: | Mathing *||

Back Room [ £

Front Room | 1, Small Reom Interiar %

Ak Room Portal component

4. In the Scene window, a Portal is represented with a yellow ribbon
around it indicating its size and the orientation in which it should be
placed. The red line shows the separation between front and back
areas of the Portal. The front is in the same direction as the local z
axis.



Ak Room Portal in the Scene window

5. Start the game. You should already see the Draw Sound
Propagation drawings indicating where the sound will be coming
from through the portal. The sphere on the left comes from the small
room emitter and the one on the right from the large room emitter.
You can see the latter is actually coming from the Portal connecting
the small and large Rooms. The sound propagation is represented
by red and blue spheres that change in size depending on the wet
and dry diffraction angles respectively.



Game window at Start

1. Connect to Wwise.
2. Play the button outside and go inside the small room.

1. You should see the same sound propagation drawings
coming from the outside emitter through the portal
connecting with the outside.

Sound Propagation drawings from Button Outside
when the listener is inside Small Room Interior

2. Move in and out of sight to hear the diffraction applied on
the sound. You will hear more or less diffraction depending



on the angle of the listener vs. the portal. In the next image,
we are watching the listener and Button Outside. You can
see a top view of the scene in the Game Object 3D Viewer.
In dark red, we can see the portals. The one in the middle is
the Outside Portal, the area on top of the Portal is the Small
Room Interior and the area on the bottom is the outside.
The Listener is in the Small Room Interior and the playing
emitter is Button Outside. On the image, you can see the
sound propagation in green between the listener and the
emitter. The Diffraction angle is 103.3. Also, you can see
the virtual position of the Button Outside emitter on the
right. That's where the sound you hear will go through the
portal.

Game Object 30 Viewer

Camera = | Reset Locate Object = Fallow

Diffraction: 103.3°

Button Cutside

Portal diffraction angle on Game Object 3D Viewer

Note: At this point, if you change the position of the rooms



or multi-edit portals, the front and back rooms will not
update, unless you open each individual AkRoomPortal
inspector. In a scene with a lot of portals, this is not
convenient, so you can use the AkRoomPortal Baker
window we added as an example in this tutorial. Open the
window from the menu: Wwise > AkRoomPortal Baker...
Click the bake button to update the front and back rooms of
all the portals in the scene.



E. Portals and Reverb

Sound emitted through Portals can also use the reverb from the current
Room the listener is in.

1. Open the SmallRoom Auxiliary Bus Property Editor and check Use
game-defined auxiliary sends in the General Settings tab. This will

send the small Room reverb to other reverbs in the scene.
K3 smalRoom - Ausiiary Bus Property Editor 4]

Mame SmallRoom
General Settings = Effects  Positioning  RTPC

Meter
Low-pass filter High-pass filter

Game-Defined Auxiliary Sends

Usge game-defined auxiliary sends

Volume mH _ﬂ

. User-Defined Auxiliary Sends
H| ]

el ID | Auxiliary Bus Volume

=5 ] ——
3 || —
Channel Configuration

Parent

Auxiliary Bus Property Editor General Settings tab to send
room reverb to other reverbs

2. When playing the small room emitter, and going into the large room,
you will see the small room's reverb feeding into the large room's
reverb.



Advanced Profiler

Voices Graph  Voices Busses Sends Emitter-listener Memory Streams  Streaming Devices  Plug-ns  Listeners

Filter: e Filfer leset

Button Small Room reverb sending to Large Room Interior
room's reverb on the Voices Graph



F. Surface Reflectors and Reverb

It is also possible to feed early reflections into the reverb of a Room. Let's
add surface reflectors in our scene.

1. Following section Surface Reflectors Tutorial,

1.
2.

3.

Add an Auxiliary Bus with the Reflect Effect.

Link each Ak Spatial Audio Emitter to the new Reflect
Auxiliary Bus.

Add Ak Surface Reflector components on all the walls and the
floor.

2. In the Wwise project, open the Auxiliary Bus with the Reflect Effect
applied to it.

1.

In the General Settings tab, check Use game-defined auxiliary
sends.

ﬁ ThirdPerson - Auxiliary Bus Property Editor

MName ThirdPerson
General Settings  Effects  Positioning RTPC  States

Output Bus
Valume Low-pass filter

/SN —

Game-Defined Auxiliary Sends

Bus Meter

Higll-pass filter
] —

Use game-defined auxiliary sends

Volume |I'||:| 0 S
|T'||E| § User-Defined Auxiliary Sends

Volume Wolume

D | Auxiliary Bus

O R O
IEIRINIE
INIsIsI

JASSE 555 2SS ass|

Channel Configuration

Parent

Auxiliary Bus Property Editor General Settings tab to send
early reflection to the room reverb

3. Play the scene and press the button in the small Room. With the



player in the small Room, here is the Voices Graph we see:

Advanced Profiler BEE

| Voices Graph  Voices Busses Sends  Emitter-listener Memory Streams  Streaming Devi Plugdns  Listen

Filter: v Filfer

Early reflections in the small room are sent to the small room's
reverb in the Voices Graph
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Obstruction and Occlusion

It is possible to obstruct or occlude sounds in Unity. See the following
sections for details:

e A. Emitter Obstruction/Occlusion
e B. Portal Obstruction



A. Emitter Obstruction/Occlusion

An emitter can be obstructed or occluded in Unity when the Ak Emitter
Obstruction Occlusion component is added to its GameObject. When
your map doesn't use spatial audio, that is it doesn't have any Ak Room
components, the Ak Emitter Obstruction Occlusion component will
only use occlusion. In a spatial audio scene, this same component will
use obstruction with the spatial audio listener only; the GameObject with
the Ak Spatial Audio Listener component. Emitter obstruction is applied
to emitters that are in the same room as the spatial audio listener.

1. Add an Ak Emitter Obstruction Occlusion component to Button
Outside.

1. In Layer Mask, select layers that would block audio. In the
SpatialAudioTutorial scene provided with the integration, we
have put the first person character on a user created layer
called "Player" and the GameObjects with AkRoom or
AkRoomPortal components on a user created layer called
"Ignore Audio Raycast". These layers are not selected in the
Layer Mask option.

¥ @ [+ Ak Emitter Obstruction Occlusion (Script) _ ﬁ i,
Script AlkEmitterObstructionOcclusion @
Layer Mask | Mixed ... ¢ |
Refresh Interval 1
Fade Time 0.5
Max Distance -1

Ak Emitter Obstruction Occlusion component



7 || [+ Ak Bank (Script) Nothing *,
| Load On: : ¢ |
Everything
| Unload On: " Default *||
P ——— ~  TransparentFx
Decode compressed data: ~  Ignore Raycast
| Bank Mame: - B ]|
» Ll
7 || [« Ak Emitter Obstruction . , . poo o &,
Script Eion @
Layer Mask | S :
Refresh Interval [
Fade Time |0.5
Max Distance -1

Layer Mask options for the Ak Emitter Obstruction
Occlusion component

2. Play the scene.
1. Play Button Outside.
2. Go behind the Barrier GameObject to hear it occluded or
obstructed depending on the presence of any GameObjects with
the Ak Room component in your scene.



B. Portal Obstruction

Sound emitted through portals can also be obstructed. Use the Ak Room
Portal Obstruction component on a game object with an Ak Room
Portal component to do so. See section Rooms and Portals Tutorial to
add rooms and portals to your scene, if not done already.

1. Add an Ak Room Portal Obstruction component to Outside Portal.
1. In Layer Mask, select layers that would block audio. In the
SpatialAudioTutorial scene provided with the integration, we
have put the the GameObjects with AkRoom components on a
user created layer called "Ignore Audio Raycast". This layer is
not selected in the Layer Mask option.

'@ [+ Ak Room Portal Obstruction {Script_] ﬁ i,
Script AlkRoomPortalObstruction (o]
Layer Mask | Mixed ... ¢ |
Refresh Interval 1
Fade Time 0.5
Max Distance -1

Ak Room Portal Obstruction component

¥ @ [+ Ak Room Portal Obstruction _{Script] ﬁ i,
Script AlkRoomPortalObstruction @
Layer Mask | Mizxed ... ¢ |
Refresh Interval ' MNothing
Fade Time ' :

Everythin
Max Distance yEhng
Default
: TransparentFX

Ignore Raycast
Water
Ul

LSRG e

Audio Rooms

v Player

Layer Mask options for the Ak Room Portal Obstruction
component

2. Play the scene.
1. Play Button Small Room.



2. Go behind the Barrier GameObject to obstruct the portal.
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Unity DIINotFoundException

Wwise Profiler
—— Unity
Mac Wwise SoundBank —— Wwise IDs.h

Mac Unity Console ""
Xbox One ""



Wwise 2013.2.8
UNITY_PROJECT_ROOT\Assets\Wwise\Deployment\Examples
Components Examples

UnityPackage



Unity DIINotFoundException

Windows Unity AkSoundEngine DIINotFoundException

e DirectX
e Wwise-Unity Integration Debug config Microsoft Visual Studio
2010 Debug Redistributables Profile Debug config



Windows Mac Editor

SoundBank Unity Wwise Generated
SoundBanks SoundBank StreamingAssets
Wwise SoundBank

Sound Engine Sound Engine Script Execution
Ordermenu Edit > Project Settings > Script Execution Order
Aklnitializer AkTerminator

Unity ......

Wwise Profiler Wwise F7 Capture Log

Wwise Profiler SoundBank Profiling SettingsAlt-
G SoundBank

Wwise Profiler Capture Log Event
SoundBank Event AKEventAkAmbient
AkSoundEngine.PostEvent



Wwise Profiler

Windows
e Unity background Run menu File > Build Settings > Player
Settings
e 24024 Wwise
e Wwise-Unity Plug-in Debug Profile

Task Manager "adb.exe"” Android TCP
Android Android Google

Wwise Remote Connection IP connect To IP

24024 traffic



—— Unity

Unity Wwise: Error during installation: Access to the path is denied

Assets > Wwise > Install Plugins Debug Profile Release
wwise Setup Unity Integration

o Unity Editor Scene
Unity Plug-in Debug Profile Release Unity wwiseids_error
Mac Wwise SoundBank Wwise_IDs.h
Mac Wwise SoundBank Wwise IDs.h

Wwise
SoundBanks
Header file path SoundBank



Wwise AkSoundEngine



Mac Unity Console ""

Mac Unity Integration Unity Console

Multiple plug-ins with the same name 'aksoundengine' (found at
'Assets/Wwise/Deployment/Plugins/Mac/Release/AkSoundEngine.bu

and
'Assets/Wwise/Deployment/Plugins/IMac/Debug/AkSoundEngine.bun

Editor Editor



Xbox One ""

Xbox One Unity Wwise Assets > Project
Settings > Audio "Disable audio"

Unity 5.0.2 "Disable audio" Aklnitializer.cs

AkPlatformInitSettings platformSettings = new Ak
PlatformInitSettings();

AkSoundEngine.GetDefaultPlatformInitSettings(pla
tformSettings);

platformSettings.uLEngineDefaultPoolSize = (uint
)lowerPoolSize * 1024;

platformSettings.fLEngineDefaultPoolRatioThresho
1d = memoryCutoffThreshold;

AkPlatformInitSettings platformSettings = new Ak
PlatformInitSettings();
AkSoundEngine.GetDefaultPlatformInitSettings(pla
tformSettings);
platformSettings.uLEngineDefaultPoolSize = (uint
)lowerPoolSize * 1024;
platformSettings.fLEngineDefaultPoolRatioThresho
1d = memoryCutoffThreshold;
#1f UNITY_XBOXONE && !'UNITY_EDITOR
platformSettings.uMaxXMAVoices = 0;
#endif

XMA
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AK:

AK:

AK:

AK:

AK:

AK:

AK:

AK:

AK:

AK:

:‘Wwise:

:‘Wwise:

:‘Wwise:

:‘Wwise:

:‘Wwise:

:‘Wwise:

:‘Wwise:

:‘Wwise:

:‘Wwise:

:‘Wwise:

:AcousticTexture

:AuxBus

:Bank

:BaseGroupType

:BaseType

:CallbackFlags

:Event

:RTPC

:State

:Switch



AK::Wwise::Trigger

AkAmbient

AkAudioListener



AkBank

AkCallbackManager

AKEmitterObstructionOcclusion

AKEnvironment

AKEnvironment::AKEnvironment_CompareBySelectionAlgorithm



AKEnvironmentPortal

AKEvent

AKkEventCallbackMsg

AkGameObj



Akinitializer
AkMemBankLoader

AkRoom

AkRoomPortal

AkRoomPortalObstruction

AkSpatial AudioEmitter

AkSpatialAudioListener



AkState

AkSurfaceReflector

AkSwitch

AkTerminator
AkTriggerBase
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AK::Wwise::AcousticTexture

This type represents an Acoustic Texture. ...

AK::Wwise::AcousticTexture
Al Whwise:BaseType

T

| AkcWwisesAcousticTexture




This type represents an Acoustic Texture.
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AK::Wwise::AuxBus

This type represents an auxiliary send in the Master-Mixer Hierarchy. ...

AK::Wwise::AuxBus

Al Whwise:BaseType

T

| AkWwisessuxBus |




This type represents an auxiliary send in the Master-Mixer Hierarchy.
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AK::Wwise::Bank
This type can be used to load/unload SoundBanks. ...

AK::Wwise::Bank

Al Whwise:BaseType

T

| Bk Waise:Bank |




This type can be used to load/unload SoundBanks.
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AK::Wwise::BaseGroupType

This type represents the base for all Wwise Types that also require a
group GUID, such as State and Switch. ...

AK::Wwise::BaseGroupType

Al Whwise:BaseType

T

| Al Whwise:BaseGroupType |

i
| |

AkWhwise:State AkcWhwise:Switch




This type represents the base for all Wwise Types that also require a
group GUID, such as State and Switch.
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AK::Wwise::BaseType

This type represents the base for all Wwise Types that require a GUID.

AK::Wwise::BaseType

Ak:Wwise:BaseType

AKWwises AcousticTexture Ak:Wwise: AuxBus AK:Wwise:Bank Ak:Wwise:BaseGroupType AR Wwise:Event Ak Wwise:RTPC AkWwise: Trigger

AR Mhwise:State ARCWwise:Switch




This type represents the base for all Wwise Types that require a GUID.
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AK::Wwise::CallbackFlags

This type represents the values of the flags used when posting an Event
with a callback. ...




This type represents the values of the flags used when posting an Event
with a callback.
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AK::Wwise::Event
This type can be used to post Events to the sound engine. ...

AK::Wwise::Event
Al Whwise:BaseType

T

| Ak WhwisesEvent |




uint

uint

uint

void

void

void

void

void

Post (GameObject gameObject)
Posts this Event on a GameObject.

Post (GameObject gameObject, CallbackFlags flags,
AkCallbackManager.EventCallback callback, object cookie=null)

Posts this Event on a GameObject.

Post (GameObject gameObject, uint flags,
AkCallbackManager.EventCallback callback, object cookie=null)

Posts this Event on a GameObject.

ExecuteAction (GameObject gameObject,
AkActionOnEventType actionOnEventType, int transitionDuration,
AkCurvelnterpolation curvelnterpolation)

Executes various actions on this event associated with a
GameObiject.

PostMIDI (GameObject gameObject, AKMIDIPostArray array)
Posts MIDI Events on this Event associated with a GameObject.

PostMIDI (GameObject gameObject, AKMIDIPostArray array, int
count)
Posts MIDI Events on this Event associated with a GameObject.

StopMIDI (GameObject gameObiject)
Stops MIDI Events on this Event associated with a GameObject.

StopMIDI ()
Stops all MIDI Events on this Event.




This type can be used to post Events to the sound engine.
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AK::Wwise::RTPC

This type can be used to set game parameter values to the sound
engine. ...

AK::Wwise::RTPC

Al Whwise:BaseType

T

| Bk Wwise:RTPC |




This type can be used to set game parameter values to the sound
engine.
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AK::Wwise::State
This type can be used to set Wwise States. ...

AK::Wwise::State
Al Whwise:BaseType

T

AlWhwise:BaseGroupType

T

AkWhwise:State




This type can be used to set Wwise States.
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AK::Wwise::Switch

This type can be used to set Switch values on gameobjects. ...

AK::Wwise::Switch

Al Whwise:BaseType

T

AlWhwise:BaseGroupType

T

AkcWhwiseSwitch




This type can be used to set Switch values on gameobjects.
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AK::Wwise::Trigger
This type can be used to post triggers to the sound engine. ...

AK::Wwise::Trigger

Al Whwise:BaseType

T

| Al WhwiseTrigoer |




This type can be used to post triggers to the sound engine.
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AkAmbient

Use this component to attach a Wwise Event to any object in a scene.
The sound can be started at various moments, dependent on the
selected Unity trigger. This component is more useful for ambient sounds
(sounds related to scene-bound objects) but could also be used for other
purposes. Since AkAmbient has AKEvent as its base class, it features
the play/stop, play multiple, stop multiple and stop all buttons for
previewing the associated Wwise event. ...

AkAmbient

AkEvent

Akamhient



int

GameObject

bool

AkActionOnEventType

AkCurvelnterpolation

float

const int

List< int >

bool

eventlD =0
ID of the Event as found in the WwiselD.cs file.

soundEmitterObject = null

Game object onto which the Event will be postec
By default, when empty, it is posted on the same
object on which the component was added.

enableActionOnEvent = false

Enables additional options to reuse existing
events. Use it to transform a Play event into a St
event without having to define one in the Wwise
Project.

actionOnEventType =
AKkActionOnEventType.AkActionOnEventType_<

Replacement action. See
AK::SoundEngine::ExecuteEventOnAction().

curvelnterpolation =
AkCurvelnterpolation.AkCurvelnterpolation_Line

Fade curve to use with the new Action. See
AK::SoundEngine::ExecuteEventOnAction().

transitionDuration = 0.0f
Duration of the fade. See
AK::SoundEngine::ExecuteEventOnAction().

MAX_NB_TRIGGERS = 32

Since our mask is a 32 bits integer, we can't hav
more than 32 triggers.

triggerList = new List<int>() {
START_TRIGGER_ID}

List containing the enabled triggers.

useOtherObject = false
This property is usefull only when used with
colliders. When enabled, the target of the action



will be the other colliding object. When disabled,
will be the current object.



o : : triggerTypes =

static Dictionary< uint, string > AkTriggerBase.GetAllDerivedTypes ()
Will contain the types of all the triggers
derived from AkTriggerBase at
runtime.




Use this component to attach a Wwise Event to any object in a scene.
The sound can be started at various moments, dependent on the
selected Unity trigger. This component is more useful for ambient sounds
(sounds related to scene-bound objects) but could also be used for other
purposes. Since AkAmbient has AKEvent as its base class, it features
the play/stop, play multiple, stop multiple and stop all buttons for
previewing the associated Wwise event.

inspector AkAmbient

AkGameObj

AKEvent

Integration Details - Events (Note: This is described in the
Wwise SDK documentation.)
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AkAudioListener

Add this script on the game object that represent a listener. This is
normally added to the Camera object or the Player object, but can be
added to any game object when implementing 3D busses.
isDefaultListener determines whether the game object will be
considered a default listener - a listener that automatically listens to all
game objects that do not have listeners attached to their
AkGameObijListenerList's. ...




Add this script on the game object that represent a listener. This is
normally added to the Camera object or the Player object, but can be
added to any game object when implementing 3D busses.
isbDefaultListener determines whether the game object will be
considered a default listener - a listener that automatically listens to all
game objects that do not have listeners attached to their
AkGameObijListenerList's.

e Integrating Listeners (Note: This is described in the Wwise SDK
documentation.)
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AkBank

Loads and unloads a SoundBank at a specified moment. Vorbis sounds
can be decompressed at a specified moment using the decode
compressed data option. In that case, the SoundBank will be prepared.

AkUnityEventHandler



override void HandleEvent (GameObject in_gameObject)
Loads the SoundBank.

void UnloadBank (GameObject in_gameObject)
Unloads a SoundBank.



string

bool

bool

bool

List< int >

const int

List< int >

bool

bankName =
Name of the SoundBank, as specified in the Wwise project.

loadAsynchronous = false

Check this to load the SoundBank in the background. Be
careful, if Events are triggered and the SoundBank hasn't
finished loading, you'll have "Event not found" errors.

decodeBank = false
Decode this SoundBank upon load.

saveDecodedBank = false
Save the decoded SoundBank to disk for faster loads in the
future.

unloadTriggerList = new List<int>()
{AkUnityEventHandler.DESTROY_TRIGGER_ID }
Reserved.

MAX_NB_TRIGGERS = 32
Since our mask is a 32 bits integer, we can't have more
than 32 triggers.

triggerList = new List<int>() { START_TRIGGER_ID }
List containing the enabled triggers.

useOtherObject = false

This property is usefull only when used with colliders.
When enabled, the target of the action will be the other
colliding object. When disabled, it will be the current object.



o : : triggerTypes =

static Dictionary< uint, string > AkTriggerBase.GetAllDerivedTypes ()
Will contain the types of all the triggers
derived from AkTriggerBase at
runtime.




Loads and unloads a SoundBank at a specified moment. Vorbis sounds
can be decompressed at a specified moment using the decode
compressed data option. In that case, the SoundBank will be prepared.
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AkCallbackManager

This class manages the callback queue. All callbacks from the native
Wwise SDK go through this queue. The queue needs to be driven by

regular calls to PostCallbacks(). This is currently done in Aklnitializer.cs,
in LateUpdate(). ...



SetMonitoringCallback (AkMonitorErrorLevel in_Level,
MonitoringCallback in_CB)

Call this to set a function to call whenever Wwise prints a
message (warnings or errors).
static void SetBGMCallback (BGMCallback in_CB, object in_cookie)
static int PostCallbacks ()

static void




This class manages the callback queue. All callbacks from the native
Wwise SDK go through this queue. The queue needs to be driven by

regular calls to PostCallbacks(). This is currently done in Aklnitializer.cs,
in LateUpdate().
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AKEmitterObstructionOcclusion

Obstructs/Occludes the emitter of the current game object from its
listeners if at least one object is between them. ...

AkODbstructionOcclusion



LayerMask

float

float

float

LayerMask = -1
Indicates which layers act as obstructers/occluders.

refreshinterval = 1

The number of seconds between obstruction/occlusion
checks.

fadeTime = 0.5f
The number of seconds for fade ins and fade outs.

maxDistance = -1.0f

The maximum distance at which to perform
obstruction/occlusion. A negative value will be interpreted
as inifinite distance.




Obstructs/Occludes the emitter of the current game object from its
listeners if at least one object is between them.

The current implementation does not support occlusion.
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AKEnvironment

Use this component to define a reverb zone. This needs to be added to a
collider object to work properly. inspector AKEvironment
AKEvironmentPortal



class AkEnvironment_CompareBySelectionAlgorithm




Use this component to define a reverb zone. This needs to be added to a
collider object to work properly. inspector AKEvironment
AKEvironmentPortal

This component can be attached to any collider. You can specify a roll-off
to fade-in/out of the reverb. The reverb parameters will be defined in the
Wwise project, by the sound designer. All AkGameObj that are
"environment"-aware will receive a send value when entering the
attached collider.

e inspector AKEvironment AkEvironmentPortal

e Integrating Environments and Game-defined Auxiliary Sends
(Note: This is described in the Wwise SDK documentation.)

e AK::SoundEngine::SetGameObjectAuxSendValues (Note: This
is described in the Wwise SDK documentation.)
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AKEnvironment::AKEnvironment_CompareBySel

AKEnvironment::AKEnvironment_CompareByPriority




The selection algorithm is as follow:

1. Environments have priorities.

2. Environments have a "Default” flag. This flag effectively says that
this environment will be bumped out if any other is present.

3. Environments have an "Exclude Other" flag. This flag will tell that this
env is not overlappable with others. So, only one (the highest
priority) should be selected.
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AKEnvironmentPortal

Use this component to define an area that straddles two different
AKEnvironments zones and allow mixing between both zones.
inspector AKEvironment AKEvironmentPortal



float GetAuxSendValueForPosition (Vector3 in_position, int index)
The axis used to find the contribution of each environment.



Vector3 axis = new Vector3(1,0,0)




Use this component to define an area that straddles two different
AKEnvironments zones and allow mixing between both zones.
inspector AKEvironment AkEvironmentPortal
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AKEvent

Helper class that knows a Wwise Event and when to trigger it in Unity. As
of 2017.2.0, the AKEvent inspector has buttons for play/stop, play
multiple, stop multiple, and stop all. Play/Stop will play or stop the event
such that it can be previewed both in edit mode and play mode. When
multiple objects are selected, Play Multiple and Stop Multiple will play or
stop the associated AkEvent for each object. ...

Akamhbient

AkEvent



int

GameObject

bool

AkActionOnEventType

AkCurvelnterpolation

float

const int

List< int >

bool

eventlD =0
ID of the Event as found in the WwiselD.cs file.

soundEmitterObject = null

Game object onto which the Event will be postec
By default, when empty, it is posted on the same
object on which the component was added.

enableActionOnEvent = false

Enables additional options to reuse existing
events. Use it to transform a Play event into a St
event without having to define one in the Wwise
Project.

actionOnEventType =
AKkActionOnEventType.AkActionOnEventType_<

Replacement action. See
AK::SoundEngine::ExecuteEventOnAction().

curvelnterpolation =
AkCurvelnterpolation.AkCurvelnterpolation_Line

Fade curve to use with the new Action. See
AK::SoundEngine::ExecuteEventOnAction().

transitionDuration = 0.0f
Duration of the fade. See
AK::SoundEngine::ExecuteEventOnAction().

MAX_NB_TRIGGERS = 32

Since our mask is a 32 bits integer, we can't hav
more than 32 triggers.

triggerList = new List<int>() {
START_TRIGGER_ID}

List containing the enabled triggers.

useOtherObject = false
This property is usefull only when used with
colliders. When enabled, the target of the action



will be the other colliding object. When disabled,
will be the current object.



o : : triggerTypes =

static Dictionary< uint, string > AkTriggerBase.GetAllDerivedTypes ()
Will contain the types of all the triggers
derived from AkTriggerBase at
runtime.




Helper class that knows a Wwise Event and when to trigger it in Unity. As
of 2017.2.0, the AKEvent inspector has buttons for play/stop, play
multiple, stop multiple, and stop all. Play/Stop will play or stop the event
such that it can be previewed both in edit mode and play mode. When
multiple objects are selected, Play Multiple and Stop Multiple will play or
stop the associated AkEvent for each object.

e Edit Mode Support
e inspector AkAmbient
e Integration Details - Events (Note: This is described in the

Wwise SDK documentation.)
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AkEventCallbackMsg

Event callback information. Event callback functions can receive this
structure as a parameter. ...



GameObject sender
AkSoundEngine.PostEvent callback flags. See the
AkCallbackType enumeration for a list of all callbacks.
AkCallbackinfo info

GameObject from whom the callback function was
called.




Event callback information. Event callback functions can receive this
structure as a parameter.
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AkGameObj

This component represents a sound object in your scene tracking its
position and other game syncs such as Switches, RTPC and
environment values. You can add this to any object that will emit sound,
and it will be added to any object that an AkAudioListener is attached
to. Note that if it is not present, Wwise will add it automatically, with the
default values, to any Unity Game Object that is passed to Wwise. ...



bool

bool

virtual Vector3
virtual Vector3
virtual Vector3

AddListener (AkAudioListener listener)

Adds an AkAudioListener to the container of listeners
listening to this gameobject.

RemovelListener (AkAudioListener listener)
Removes an AkAudioListener from the container of

listeners listening to this gameobject.
GetPosition ()
GetForward ()
GetUpward ()



AkGameObjPositionOffsetData m_positionOffsetData = null

bool

When not set to null, the position will
be offset relative to the Game Object
position by the Position Offset.

isEnvironmentAware = true

Is this object affected by Environment
changes? Set to false if not affected in
order to save some useless calls.
Default is true.




This component represents a sound object in your scene tracking its
position and other game syncs such as Switches, RTPC and
environment values. You can add this to any object that will emit sound,
and it will be added to any object that an AkAudioListener is attached
to. Note that if it is not present, Wwise will add it automatically, with the
default values, to any Unity Game Object that is passed to Wwise.

¢ Integration Details - Game Objects (Note: This is described in
the Wwise SDK documentation.)

e Integration Details - Events (Note: This is described in the
Wwise SDK documentation.)

e Integrating Listeners (Note: This is described in the Wwise SDK
documentation.)

¢ |ntegration Details - Switches (Note: This is described in the
Wwise SDK documentation.)

¢ |ntegration Details - States (Note: This is described in the Wwise
SDK documentation.)

e Integration Details - Environments and Game-defined Auxiliary
Sends (Note: This is described in the Wwise SDK
documentation.)
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Aklnitializer



string

string

int

int

int

int

float

int

basePath = AkSoundEngineController.s_DefaultBas

Path for the soundbanks. This must contain one sub
per platform, with the same as in the Wwise project.

language = AkSoundEngineController.s_Language
Language sub-folder.

defaultPoolSize =
AkSoundEngineController.s_DefaultPoolSize
Default Pool size. This contains the meta data for yo
project. Default size is 4 MB, but you should adjust fi
needs.

lowerPoolSize = AkSoundEngineController.s_Lowe
Lower Pool size. This contains the audio processing
and DSP data. Default size is 2 MB, but you should ¢
for your needs.

streamingPoolSize =
AkSoundEngineController.s_StreamingPoolSize
Streaming Pool size. This contains the streaming bu
Default size is 1 MB, but you should adjust for your r

preparePoolSize =
AkSoundEngineController.s_PreparePoolSize
Prepare Pool size. This contains the banks loaded u
PrepareBank (Banks decoded on load use this). Def
Is 0 MB, but you should adjust for your needs.

memoryCutoffThreshold =
AkSoundEngineController.s_MemoryCutoffThresholt
This setting will trigger the killing of sounds when the
memory is reaching 95% of capacity. Lowest priority
are killed.

monitorPoolSize =
AkSoundEngineController.s_MonitorPoolSize
Monitor Pool size. Size of the monitoring pool, in byt
parameter is not used in Release build.



int

int

int

uint

AkDiffractionFlags

bool

monitorQueuePoolSize =

AkSoundEngineController.s_MonitorQueuePoolSize
Monitor Queue Pool size. Size of the monitoring que
In bytes. This parameter is not used in Release build

callbackManagerBufferSize =
AkSoundEngineController.s_CallbackManagerBuffer
CallbackManager buffer size. The size of the buffer
per-frame to transfer callback data. Default size is 4
you should increase this, if required.

spatialAudioPoolSize =
AkSoundEngineController.s_SpatialAudioPoolSize
Spatial Audio Lower Pool size. Default size is 4 MB,
should adjust for your needs.

maxSoundPropagationDepth =
AkSoundEngine.AK_MAX_SOUND_PROPAGATIOM
Spatial Audio Max Sound Propagation Depth. Maxin
number of rooms that sound can propagate through;
less than or equal to

AK_MAX SOUND_PROPAGATION_DEPTH.

diffractionFlags = AkDiffractionFlags.DefaultDiffrac
Enable or disable specific diffraction features. See
AkDiffractionFlags.

engineLogging =
AkSoundEngineController.s_EnginelLogging

Enable Wwise engine logging. Option to turn on/off t
logging of the Wwise engine.




This script deals with initialization, and frame updates of the Wwise audio
engine. It is marked as pontDestroyonLoad SO it stays active for the life of
the game, not only one scene. You can, and probably should, modify this
script to change the initialization parameters for the sound engine. A few
are already exposed in the property inspector. It must be present on one
Game Object at the beginning of the game to initialize the audio properly.
It must be executed BEFORE any other MonoBehaviors that use
AkSoundEngine.

¢ |nitialize the Different Modules of the Sound Engine (Note: This
is described in the Wwise SDK documentation.)

e AK::SoundEngine::Init() (Note: This is described in the Wwise
SDK documentation.)

o AK::SoundEngine:: Term() (Note: This is described in the Wwise
SDK documentation.)

e AkCallbackManager
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AkMemBankLoader



void LoadNonLocalizedBank (string in_bankFilename)
Load a sound bank from WWW object.

void LoadLocalizedBank (string in_bankFilename)
Load a language-specific bank from WWW object.



string bankName =""
Name of the bank to load.
bool isLocalizedBank = false
Is the bank localized (situated in the language specific folders).




This class is an example of how to load banks in Wwise, if the bank data
was preloaded in memory. This would be useful for situations where you
use the WWW class
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AkRoom

An AkRoom is an enclosed environment that can only communicate to
the outside/other rooms with AkRoomPortals. ...



ulong GetiD ()
Access the room's ID.



AK.Wwise.AuxBus reverbAuxBus
The reverb auxiliary bus.

float reverbLevel =1
The reverb control value for the send to the
reverb aux bus.

float wallOcclusion =1
Occlusion level modeling transmission through
walls.

int priority =0




An AkRoom is an enclosed environment that can only communicate to
the outside/other rooms with AkRoomPortals.
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AkRoomPortal

An AkRoomPortal can connect two AkRoom components together. ...

AkUnityEventHandler



ulong GetlD ()
Access the portal's ID.

override void HandleEvent (GameObject in_gameObject)
Opens the portal on trigger event.

void ClosePortal (GameObiject in_gameObject)
Closes the portal on trigger event.



const int

AkRoom(]
const int

List< int >

bool

MAX_ROOMS_PER_PORTAL =2
AkRoomPortals can only connect a maximum of 2 rooms.

rooms = new AKRoom[MAX_ROOMS_PER_PORTAL]
MAX_NB_TRIGGERS = 32

Since our mask is a 32 bits integer, we can't have more
than 32 triggers.

triggerList = new List<int>() { START_TRIGGER_ID }
List containing the enabled triggers.

useOtherObject = false

This property is usefull only when used with colliders.
When enabled, the target of the action will be the other
colliding object. When disabled, it will be the current
object.



o : : triggerTypes =

static Dictionary< uint, string > AkTriggerBase.GetAllDerivedTypes ()
Will contain the types of all the triggers
derived from AkTriggerBase at
runtime.




An AkRoomPortal can connect two AkKRoom components together.
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AkRoomPortalObstruction

Obstructs/Occludes the spatial audio portal of the current game object
from the spatial audio listener if at least one object is between them. ...

AkODbstructionOcclusion



LayerMask

float

float

float

LayerMask = -1
Indicates which layers act as obstructers/occluders.

refreshinterval = 1

The number of seconds between obstruction/occlusion
checks.

fadeTime = 0.5f
The number of seconds for fade ins and fade outs.

maxDistance = -1.0f

The maximum distance at which to perform
obstruction/occlusion. A negative value will be interpreted
as inifinite distance.




Obstructs/Occludes the spatial audio portal of the current game object
from the spatial audio listener if at least one object is between them.

If no spatial audio listener has been registered, there will be no
obstruction.
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AkSpatialAudioEmitter

Add this script on the GameObject which represents an emitter that uses
the Spatial Audio API. ...

AkSpatialAudioBase



AK.Wwise.AuxBus reflectAuxBus
The Auxiliary Bus with a Reflect plug-in Effect
applied.

uint reflectionsOrder =1

float reflectionsAuxBusGain =1
The gain [0, 1] applied to the reflect auxiliary bus.

float reflectionMaxPathLength = 1000
A heuristic to stop the computation of reflections.
Should be no longer (and possibly shorter for
less CPU usage) than the maximum attenuation
of the sound emitter.

float roomReverbAuxBusGain =1
Send gain (0.f-1.f) that is applied when sending
to the aux bus associated with the room that the
emitter is in.




Add this script on the GameObject which represents an emitter that uses
the Spatial Audio API.
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AkSpatialAudioListener

Add this script on the game object that represent a listener. This is
normally added to the Camera object or the Player object, but can be
added to any game object when implementing 3D busses.
isDefaultListener determines whether the game object will be
considered a default listener - a listener that automatically listens to all
game objects that do not have listeners attached to their
AkGameObijListenerList's. ...

AkSpatialAudioBase




Add this script on the game object that represent a listener. This is
normally added to the Camera object or the Player object, but can be
added to any game object when implementing 3D busses.
isbDefaultListener determines whether the game object will be
considered a default listener - a listener that automatically listens to all
game objects that do not have listeners attached to their
AkGameObijListenerList's.

e Integrating Listeners (Note: This is described in the Wwise SDK
documentation.)
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AKkState

This will call AksoundEngine.SetState() whenever the selected Unity

event is triggered. For example this component could be set on a Unity
collider to trigger when an object enters it. ...

AkUnityEventHandler



int

int

const int

List< int >

bool

groupliD
State Group ID, as defined in WwiselD.cs.

valuelD
State Value ID, as defined in WwiselD.cs.

MAX_NB_TRIGGERS = 32

Since our mask is a 32 bits integer, we can't have more
than 32 triggers.

triggerList = new List<int>() { START_TRIGGER_ID }
List containing the enabled triggers.

useOtherObject = false

This property is usefull only when used with colliders.
When enabled, the target of the action will be the other
colliding object. When disabled, it will be the current object.



o : : triggerTypes =

static Dictionary< uint, string > AkTriggerBase.GetAllDerivedTypes ()
Will contain the types of all the triggers
derived from AkTriggerBase at
runtime.




This will call Aksoundengine.setState() whenever the selected Unity
event is triggered. For example this component could be set on a Unity
collider to trigger when an object enters it.

¢ |ntegration Details - States (Note: This is described in the Wwise
SDK documentation.)
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AkSurfaceReflector

This component will convert the triangles of the GameObject's geometry
into sound reflective surfaces. ...



AddGeometrySet (AK.Wwise.AcousticTexture
acousticTexture, MeshFilter meshFilter)

Sends the mesh filter's triangles and their acoustic texture
to Spatial Audio.

static void

static void RemoveGeometrySet (MeshFilter meshFilter)

Remove the corresponding mesh filter's geometry from
Spatial Audio.



AK.Wwise.AcousticTexture AcousticTexture
All triangles of the component's mesh
will be applied with this texture. The
texture will change the filter parameters
of the sound reflected from this
component.




This component will convert the triangles of the GameObject's geometry
into sound reflective surfaces.

This component requires a Mesh Filter component. The triangles of the
mesh will be sent to the Spatial Audio wrapper by calling
SpatialAudio::AddGeometrySet(). The triangles will reflect the sound
emitted from AkSpatial AudioEmitter components.
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AkSwitch

This will call AksoundEngine.SetsSwitch() whenever the selected Unity

event is triggered. For example this component could be set on a Unity
collider to trigger when an object enters it. ...

AkUnityEventHandler



int

int

const int

List< int >

bool

groupliD
Switch Group ID, as defined in WwiselD.cs.

valuelD
Switch Value ID, as defined in WwiselD.cs.

MAX_NB_TRIGGERS = 32

Since our mask is a 32 bits integer, we can't have more
than 32 triggers.

triggerList = new List<int>() { START_TRIGGER_ID }
List containing the enabled triggers.

useOtherObject = false

This property is usefull only when used with colliders.
When enabled, the target of the action will be the other
colliding object. When disabled, it will be the current object.



o : : triggerTypes =

static Dictionary< uint, string > AkTriggerBase.GetAllDerivedTypes ()
Will contain the types of all the triggers
derived from AkTriggerBase at
runtime.




This will call AksoundEngine.SetSwitch() whenever the selected Unity
event is triggered. For example this component could be set on a Unity
collider to trigger when an object enters it.

e |ntegration Details - Switches (Note: This is described in the
Wwise SDK documentation.)
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AkTerminator




This script deals with termination of the Wwise audio engine. It must be
present on one Game Object that gets destroyed last in the game. It must
be executed AFTER any other monoBehaviors that use AkSoundEngine.

e Terminate the Different Modules of the Sound Engine (Note:
This is described in the Wwise SDK documentation.)

e AK::SoundEngine:: Term() (Note: This is described in the Wwise
SDK documentation.)
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AKTriggerBase

AkTriggerCollisionEnterAkTriggerCollisionExitAkTriggerDisable
AkTriggerEnableAkTriggerEnterAkTriggerExit
AkTriggerMouseDownAkTriggerMouseEnterAkTriggerMouseEXxit
AkTriggerMouseUp.



delegate void Trigger (GameObject in_gameObject)
Delegate declaration for all Wwise Triggers.



Trigger triggerDelegate = null
All components reacting to the trigger will be registered in this
delegate.




Base class for the generic triggering mechanism for Wwise Integration.
All Wwise components will use this mechanism to drive their behavior.
Derive from this class to add your own triggering condition, as decribed in
Wwise Events Trigger
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AK:

0O O O O

(¢]

(¢]

(0]

AK:

:Wwise::BaseType

AK::Wwise::AcousticTexture
AK::Wwise::AuxBus
AK::Wwise::Bank
AK::Wwise::BaseGroupType

» AK::Wwise::State

s AK::Wwise::Switch
AK::Wwise::Event
AK::Wwise::RTPC
AK::Wwise::Trigger

:Wwise::CallbackFlags

AkAudioListener

AkBank

AkCallbackManager
AKEmitterObstructionOcclusion
AKEnvironment

AKEnvironment::AKEnvironment_CompareBySelectionAlgorithn

AKEnvironmentPortal
AKEvent

(0]

AkAmbient

AkEventCallbackMsg
AkGameObj
AklInitializer
AkMemBankLoader
AkRoom

AkRoomPortal
AkRoomPortalObstruction
AkSpatial AudioEmitter
AkSpatialAudioListener
AkState
AkSurfaceReflector
AkSwitch

AkTerminator
AkTriggerBase
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e AcousticTexture : AkSurfaceReflector
actionOnEventType : AkKEvent
AddGeometrySet() : AkSurfaceReflector
AddListener() : AkGameObij

axis : AKEnvironmentPortal

-b-

e bankName : AkBank , AkMemBankLoader
e basePath : Akinitializer

- c -
o callbackManagerBufferSize : Aklnitializer

e ClosePortal() : AkRoomPortal
e curvelnterpolation : AKEvent

-d -
e decodeBank : AkBank

o defaultPoolSize : Akinitializer
o diffractionFlags : Aklnitializer

- e -
e enableActionOnEvent : AkEvent

e engineLogging : Aklnitializer
e eventlD : AkEvent



e ExecuteAction() : AK::Wwise::Event

GetAuxSendValueForPosition() : AKEnvironmentPortal
GetForward() : AkGameODbj

GetID() : AkRoomPortal , AkRoom

GetPosition() : AkGameObj

GetUpward() : AkGameObj

grouplD : AkSwitch , AkState

e HandleEvent() : AkBank , AkRoomPortal
-j-

¢ info : AKEventCallbackMsg
¢ isEnvironmentAware : AkGameObj
¢ isLocalizedBank : AkMemBankLoader

-/-

language : Aklnitializer

loadAsynchronous : AkBank
LoadLocalizedBank() : AkMemBankLoader
LoadNonLocalizedBank() : AkMemBankLoader
lowerPoolSize : Aklnitializer

=-m -

m_positionOffsetData : AkGameObj
MAX_ROOMS_ PER_PORTAL : AkRoomPortal
maxSoundPropagationDepth : Aklinitializer
memoryCutoffThreshold : AkInitializer
monitorPoolSize : Aklnitializer
monitorQueuePoolSize : Akinitializer



-p-

e Post() : AK::Wwise::Event

e PostCallbacks() : AkCallbackManager
e PostMIDI() : AK::Wwise::Event

e preparePoolSize : Aklnitializer

e priority : AkRoom

=F -

o reflectAuxBus : AkSpatialAudioEmitter

¢ reflectionMaxPathLength : AkSpatial AudioEmitter
e reflectionsAuxBusGain : AkSpatial AudioEmitter

o reflectionsOrder : AkSpatialAudioEmitter

e RemoveGeometrySet() : AkSurfaceReflector

e RemovelListener() : AkGameObj

e reverbAuxBus : AkRoom

e reverbLevel : AkRoom

e roomReverbAuxBusGain : AkSpatial AudioEmitter
e rooms : AkRoomPortal

-GS =

e saveDecodedBank : AkBank

e sender : AKEventCallbackMsg

e SetBGMCallback() : AkCallbackManager

e SetMonitoringCallback() : AkCallbackManager
e soundEmitterObject : AKEvent

e spatialAudioPoolSize : Aklnitializer

e StopMIDI() : AK::Wwise::Event

e streamingPoolSize : Akinitializer

-t-
e transitionDuration ;: AKEvent

o Trigger() : AkTriggerBase
o triggerDelegate : AkTriggerBase



=U -

e UnloadBank() : AkBank
e unloadTriggerList : AkBank

- v -
¢ valuelD : AkState , AkSwitch
- W -

e wallOcclusion : AkRoom
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ExecuteAction uint AK::Wwise::Event::Post (GameObject gam
Post Posts this Event on a GameObject.

Post

Post :

PostMIDI gameObject The GameObject

PostMIDI

Sfllol Returns the playing ID.

StopMIDI
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AK::Wwise::Event

ExecuteAction
Post

Post

Post

PostMIDI
PostMIDI
StopMIDI
StopMIDI

void AK::Wwise::Event::PostMIDI ( GameObject
AKMIDIPostA

)

Posts MIDI Events on this Event associated with a G

gameObject The GameObject
array The array of AkKMIDIPost that are
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Aklnitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
enginelLogging

language

lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

string Aklnitializer::basePath = Ak

Path for the soundbanks. This must c
same as in the Wwise project.
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AkCallbackManager

static void AkCallbackManager::SetMoni

PostCallbacks
SetBGMCallback
SetMonitoringCallback

Call this to set a function to call whenever
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bankName void AkMemBankLoader::LoadNonLoc
isLocalizedBank

LoadLocalizedBank Load a sound bank from WWW object.
LoadNonLocalizedBank

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by d_Q!_ h:l41]1.6.3


http://www.doxygen.org/index.html

AkCallbackManager

static void AkCallbackManager::SetBGM

PostCallbacks
SetBGMCallback
SetMonitoringCallback

Call this to set a IOS callback interruption fu
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A|B|C|E|R|S|T

AcousticTexture (AK::Wwise)

AkAmbient A
AkAudioListener
AkBank
AkCallbackManager
AKEmitterObstructionOcclusion

AKEnvironment

AKEnvironment::AKEnvironment_CompareBySelectionAlgorithm
A|B|C|E|R|S|T
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AkCallbackManager

static int AkCallbackManager::PostCallb

PostCallbacks

This function dispatches all the accumulated
SetBGMCallback sound engine. It must be called regularly. B
AklInitializer.cs.

SetMonitoringCallback
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AK::Wwise::AcousticTexture
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AK::Wwise::AuxBus

AK::Wwise::AuxBus
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AK::Wwise::Bank

AK::Wwise::Bank
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AK::Wwise::BaseGroupType

AK::Wwise::BaseGroupType

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by dﬂlxggn 1.6.3


http://www.doxygen.org/index.html

33




AK::Wwise::BaseType

AK::Wwise::BaseType
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AK::Wwise::CallbackFlags

AK::Wwise::CallbackFlags
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AK::Wwise::Event

AK::Wwise::Event
ExecuteAction(GameObject gameObject,
AkActionOnEventType actionOnEventType,
int transitionDuration, AkCurvelnterpolation
curvelnterpolation)

Post(GameObject gameObject) AK::Wwise::Event [inline]
Post(GameObject gameObject,
CallbackFlags flags,
AkCallbackManager.EventCallback
callback, object cookie=null)

Post(GameObject gameObject, uint flags,
AkCallbackManager.EventCallback AK::Wwise::Event [inline]
callback, object cookie=null)

PostMIDI(GameObject gameObiject,
AKMIDIPostArray array)

PostMIDI(GameObject gameObiject,
AKMIDIPostArray array, int count)

StopMIDI(GameObject gameObject) AK::Wwise::Event [inline]
StopMIDI() AK::Wwise::Event [inline]

AK::Wwise::Event [inline]

AK::Wwise::Event [inline]

AK::Wwise::Event [inline]

AK::Wwise::Event [inline]
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AK::Wwise::Event

uint AK::Wwise::Event::Post ( GameObject
CallbackFlags
AkCallbackManag

object
ExecuteAction )
Post
Post Posts this Event on a GameObject.
Post
FESLALIEL gameObject The GameObject
PostMIDI flags
Sgghallol callback
SHeghill2l cookie Optional cookie received by the c

Returns the playing ID.
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AK::Wwise::Event

uint AK::Wwise::Event::Post ( GameObject

uint
AkCallbackManag
object

ExecuteAction )

Post

Post Posts this Event on a GameObject.

Post

FESLALIEL gameObject The GameObject

PostMIDI flags

lefplallel callback

SHeghill2l cookie Optional cookie received by the c

Returns the playing ID.
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AK::Wwise::Event

ExecuteAction

Post
Post
Post
PostMIDI
PostMIDI
StopMIDI
StopMIDI

void AK::Wwise::Event::ExecuteAction (GameO
AKkActio
int
AkCurv

)

Executes various actions on this event associated wi

gameObject The GameObiject
actionOnEventType

transitionDuration

curvelnterpolation
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AK::Wwise::Event

void AK::Wwise::Event::PostMIDI ( GameObject

AKMIDIPostA

ExecuteAction int
Post )
Post
Post Posts MIDI Events on this Event associated with a G
PostMIDI
StopMIDI gameObject The GameObject

array The array of AKMIDIPost that are
StopMIDI

count The number of elements from the
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AK::Wwise::Event

ExecuteAction
Post void AK::Wwise::Event::StopMIDI ( GameObject
Post
Post
PostMIDI -
PostMIDI gameObject The GameObject

StopMIDI

Stops MIDI Events on this Event associated with a G
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AK::Wwise::Event

ExecuteAction

Post

Post void AK::Wwise::Event::StopMIDI ( ) [inline]
Post

PostMIDI Stops all MIDI Events on this Event.

PostMIDI

StopMIDI
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AK::Wwise::RTPC
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AK::Wwise::State

AK::Wwise::State
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AK::Wwise::Switch

AK::Wwise::Switch
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AK::Wwise::Trigger

AK::Wwise::Trigger
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AkAmbient

AkAmbient
actionOnEventType AkEvent
curvelnterpolation AKEvent
enableActionOnEvent AKEvent
eventiD AKEvent
soundEmitterObject AkEvent
transitionDuration AKEvent
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AKEvent

actionOnEventType
curvelnterpolation

enableActionOnEvent ', ¢ e Event as found in the WwiselD.cs
file.

soundEmitterObject
transitionDuration

int AKEvent::eventiD =0
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AKEvent

actionOnEventType
curvelnterpolation

enableActionOnEvent | Game object onto which the Event will be po
eventiD default, when empty, it is posted on the same

soundEmitterObject on which the component was added.
transitionDuration

GameObject AkEvent::soundEmitterObje
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AKEvent

actionOnEventType bool AkEvent::enableActionOnEvent = fal

curvelnterpolation

enableActionOnEvent Enables add!tlonal options to reuse existing
eventlD events. Use it to transform a Play event into

_ _ Stop event without having to define one in th
soundEmitterObject Wwise Project.

transitionDuration
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AKEvent

actionOnEventType

curveinterpolation AkActionOnEventType AKEvent::actionO
enableActionOnEvent
eventlD Replacement action. See AK::SoundEngine::
soundEmitterObject
transitionDuration
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AKEvent

actionOnEventType
AkCurvelnterpolation AkEvent::curvelnte
enableActionOnEvent
eventlD Fade curve to use with the new Action. See
soundEmitterObject
transitionDuration
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AKEvent

actionOnEventType
curvelnterpolation
enableActionOnEvent

float AkEvent::transitionDuration = 0.0f

Duration of the fade. See

eventlD AK::SoundEngine::ExecuteEventOnAction().
soundEmitterObject

transitionDuration
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AkSwitch

const int AkUnityEventHandler::MAX_NB_TRIGGERS =

groupiD
valuelD Since our mask is a 32 bits integer, we can't have more tha
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AkSwitch

List<int> AkUnityEventHandler::triggerList = new List<i

groupiD
valuelD List containing the enabled triggers.
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AkSwitch
bool AkUnityEventHandler::useOtherObject = false [int
groupID  This property is usefull only when used with colliders. When

valuelD enabled, the target of the action will be the other colliding ob
When disabled, it will be the current object.
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AkSwitch

Dictionary<uint, string> AkUnityEventHandler::triggerT

groupiD
valuelD @ Will contain the types of all the triggers derived from AkTrig
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AkAudioListener

AKkAudioListener
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AkBank

AkBank
bankName AkBank
decodeBank AkBank
HandleEvent(GameObiject in_gameObject) AkBank [inline]
loadAsynchronous AkBank
saveDecodedBank AkBank
UnloadBank(GameObject in_gameObject) AkBank [inline]
unloadTriggerList AkBank
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AkBank

bankName
decodeBank - -
override void AkBank::HandleEvent ( Game
HandleEvent
loadAsynchronous
saveDecodedBank
UnloadBank
unloadTriggerList

Loads the SoundBank.
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AkBank

bankName
decodeBank
HandleEvent
loadAsynchronous
saveDecodedBank

UnloadBank

unloadTriggerList

void AkBank::UnloadBank ( GameObject in

Unloads a SoundBank.
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AkBank

decodeBank string AkBank::bankName = ""
HandleEvent

loadAsynchronous | Name of the SoundBank, as specified in the
saveDecodedBank | Wwise project.

UnloadBank

unloadTriggerList
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AkBank

bankName bool AkBank::loadAsynchronous = false
decodeBank
HandleEvent Check this to load the SoundBank in the

LEGISTENGI TS | background. Be careful, if Events are triggered
saveDecodedBank @ and the SoundBank hasn't finished loading,

UnloadBank you'll have "Event not found" errors.

unloadTriggerList
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AkBank

bankName
decodeBank
HandleEvent
loadAsynchronous
saveDecodedBank
UnloadBank
unloadTriggerList

bool AkBank::decodeBank = false

Decode this SoundBank upon load.
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AkBank

bankName

decodeBank bool AkBank::saveDecodedBank = false
HandleEvent

loadAsynchronous | Save the decoded SoundBank to disk for faster

saveDecodedBank loads in the future.

UnloadBank
unloadTriggerList
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AkBank

bankName
decodeBank
HandleEvent
loadAsynchronous
saveDecodedBank
UnloadBank

unloadTriggerList

List<int> AkBank::unloadTriggerList = new

Reserved.
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AkCallbackManager

AkCallbackManager
PostCallbacks() AkCallbackManager

SetBGMCallback(BGMCallback in_CB,
object in_cookie)
SetMonitoringCallback(AkMonitorErrorLevel
in_Level, MonitoringCallback in_CB)
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AKEmitterObstructionOcclusion

AKEmitterObstructionOcclusion
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AkRoomPortalObstruction

LayerMask AkObstructionOcclusion::LayerMask = -1 [inherited:

Indicates which layers act as obstructers/occluders.
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AkRoomPortalObstruction

float AkObstructionOcclusion::refreshinterval = 1 [inherited]

The number of seconds between obstruction/occlusion checks.
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AkRoomPortalObstruction

float AkObstructionOcclusion::fadeTime = 0.5f [inherited]

The number of seconds for fade ins and fade outs.
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AkRoomPortalObstruction

float AkObstructionOcclusion::maxDistance = -1.0f [inherited]

The maximum distance at which to perform obstruction/occlusion. A
negative value will be interpreted as inifinite distance.
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AKEnvironment

AKEnvironment
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AKEnvironment::AKEnvironment_CompareBySel

AKEnvironment::AKEnvironment_CompareBySelectionAlgorithm
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AKEnvironmentPortal

AKEnvironmentPortal
axis AKEnvironmentPortal

GetAuxSendValueForPosition(Vector3

. " o AKEnvironmentPortal [inline]
in_position, int index)
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AKEnvironmentPortal

float AKEnvironmentPortal::GetA

axis

GetAuxSendValueForPosition

The axis used to find the contributio
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AKEnvironmentPortal

GetAuxSendValueForPosition

Vector3 AKEnvironmentPortal::ax

The array is already sortet by positio
is on the negative side of the portal(
of the chosen axis) The second envi
positive side of the portal
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AKEvent

AKEvent
actionOnEventType AkEvent
curvelnterpolation AKEvent
enableActionOnEvent AKEvent
eventiD AKEvent
soundEmitterObject AkEvent
transitionDuration AKEvent
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AkEventCallbackMsg

AkEventCallbackMsg
info  AkEventCallbackMsg
sender AkEventCallbackMsg
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AkEventCallbackMsg
GameObject AkEventCallbackMsg::sender
Lalie AkSoundEngine.PostEvent callback flags. See the
sender AkCallbackType enumeration for a list of all callbacks.
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AkEventCallbackMsg
AkCallbackinfo AkEventCallbackMsg::info

sender A GameObject from whom the callback function was called.
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AkGameObj

AkGameObj

AddListener(AkAudioListener listener) AkGameObj [inline]
GetForward() AkGameODbj \Eip%ﬁgi]
GetPosition() AkGameODbj \Eip%ﬁgi]
GetUpward() AkGameODbj \Eip%ﬁgi]
iIsEnvironmentAware AkGameObj
m_positionOffsetData AkGameODbj
RemoveLlstener(AkAud|0L|stener AkGameObj [inline]
listener)
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AkGameObj

bool AkGameObj::AddListener ( AkAudio

Adds an AkAudioListener to the container o

GetForward gameobject.

GetPosition

_GetUpward listener

ISEnvironmentAware

m_positionOffsetData| |:

RemovelListener Returns true if the listener was not previ
otherwise.
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AkGameObj
bool AkGameObj::RemoveListener ( AKA

AddListener Removes an AkAudioListener from the cont
GetForward gameobject.

GetPosition

GetUpward

isEnvironmentAware listener

m_positionOffsetData

Returns true if the listener was previousl
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AkGameObj

virtual Vector3 AkGameObj::GetPosition (

AddListener

el Gets the position including the position offset
GetPosition applyPositionOffset is enabled. User can als
GetUpward to calculate an arbitrary position.

isEnvironmentAware
m_positionOffsetData

. The position.
Removelistener
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AkGameObj

AddListener virtual Vector3 AkGameObj::GetForward (

GetForward _ _

GetPosition Gets the orientation forwarpl vector. User can
method to calculate an arbitrary vector.

GetUpward

isEnvironmentAware -

m_positionOffsetData The forward vector of orientation.

RemovelListener
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AkGameObj

AddListener virtual Vector3 AkGameObj::GetUpward (

GetForward _ _

GetPosition Gets the orientation upward vector. User can
method to calculate an arbitrary vector.

GetUpward

isEnvironmentAware -

m_positionOffsetData The upward vector of orientation.

RemovelListener
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AkGameObj

AddListener

GetForward AkGameObjPositionOffsetData AkGame
GetPosition

GetUpward When not set to null, the position will be offs
isEnvironmentAware position by the Position Offset.

m_positionOffsetData

RemovelListener
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AkGameObj

AddListener
GetForward bool AkGameODbj::isEnvironmentAware =

GetPosition . . .
GetU d Is this object affected by Environment chang
etUpwar Set to false if not affected in order to save so

ISEnvironmentAware useless calls. Default is true.

m_positionOffsetData
RemovelListener
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Aklnitializer

AklInitializer
basePath Aklnitializer
callbackManagerBufferSize Aklnitializer
defaultPoolSize Aklnitializer
diffractionFlags Aklnitializer
enginelLogging Aklnitializer
language Aklnitializer
lowerPoolSize AklInitializer
maxSoundPropagationDepth Akinitializer
memoryCutoffThreshold AklInitializer
monitorPoolSize AklInitializer
monitorQueuePoolSize AklInitializer
preparePoolSize Aklnitializer
spatialAudioPoolSize Aklnitializer
streamingPoolSize Aklnitializer
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Aklnitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
enginelLogging

string Akinitializer::language = Ak
lowerPoolSize
maxSoundPropagationDepth | Language sub-folder.
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize
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Aklnitializer

basePath
callbackManagerBufferSize
diffractionFlags
enginelLogging

language

foneEs e Default Pool size. This contains the

maxSoundPropagationDepth g Kyt you should adjust for your ne
memoryCutoffThreshold

monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

int Aklnitializer::defaultPoolSize =
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Aklnitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
enginelLogging

language
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

int Aklnitializer::lowerPoolSize = A

Lower Pool size. This contains the au
size is 2 MB, but you should adjust fo
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Aklnitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
enginelLogging

language

lowerPoolSize : : : :
. Streaming Pool size. This contains th
maxSoundPropagationDepth gj6y1d adjust for your needs.

memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize

streamingPoolSize

int Akinitializer::streamingPoolSiz
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Aklnitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
enginelLogging

language

lowerPoolSize _ Prepare Pool size. This contains the
maxSoundPropagationDepth | | oy |5ad use this). Default size is 0 M

memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
spatialAudioPoolSize
streamingPoolSize

int Akinitializer::preparePoolSize
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Aklnitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
enginelLogging

language

lowerPoolSize _ This setting will trigger the killing of s
maxSoundPropagationDepth | | c5,nds are killed.

monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

float Akinitializer::memoryCutoffT
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Aklnitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
enginelLogging

language

R ) Monitor Pool size. Size of the monitor
maxSoundPropagationDepth | | pojease build.
memoryCutoffThreshold
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

int Aklnitializer::monitorPoolSize
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Aklnitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
enginelLogging

language

foneEs e . Monitor Queue Pool size. Size of the
maxSoundPropagationDepth | | pojease build.
memoryCutoffThreshold
monitorPoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

int Aklnitializer::monitorQueuePo
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Aklnitializer

basePath
defaultPoolSize
diffractionFlags
enginelLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

int Aklnitializer::callbackManager

CallbackManager buffer size. The siz
KB, but you should increase this, if re
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Aklnitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
enginelLogging

language int Aklnitializer::spatialAudioPool
lowerPoolSize
maxSoundPropagationDepth  Spatial Audio Lower Pool size. Defau
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize

spatialAudioPoolSize

streamingPoolSize
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Aklnitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
enginelLogging

language

lowerPoolSize Spatial Audio Max Sound Propagatio

WENELINEIFCRELENTINEIN | pe |ess than or equal to AK_MAX_S

memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

uint Aklnitializer::maxSoundProp
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Aklnitializer

basePath
callbackManagerBufferSize
defaultPoolSize
enginelLogging

language AkDiffractionFlags Akinitializer::di
lowerPoolSize
maxSoundPropagationDepth  Enable or disable specific diffraction f
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize
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Aklnitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags

language bool Akinitializer::engineLogging
lowerPoolSize
maxSoundPropagationDepth  Enable Wwise engine logging. Option
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize
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AkMemBankLoader

AkMemBankLoader
bankName AkMemBankLoader
isLocalizedBank AkMemBankLoader

LoadLocalizedBank(string
in_bankFilename)

LoadNonLocalizedBank(string
in_bankFilename)

AkMemBankLoader [inline]

AkMemBankLoader [inline]
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AkMemBankLoader

bankName void AkMemBankLoader::LoadLocalize
isLocalizedBank

LoadLocalizedBank Load a language-specific bank from WWW
LoadNonLocalizedBank
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AkMemBankLoader

string AkMemBankLoader::bankName
isLocalizedBank

LoadLocalizedBank Name of the bank to load.
LoadNonLocalizedBank
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AkMemBankLoader

bankName bool AkMemBankLoader::isLocalizedB

isLocalizedBank

LoadLocalizedBank
LoadNonLocalizedBank

Is the bank localized (situated in the langu
specific folders).
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AkRoom

AkRoom
GetlID() AkRoom [inline]
priority AkRoom

reverbAuxBus AKkRoom
reverbLevel AkRoom
wallOcclusion AkRoom
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AkRoom

GetID

priority
reverbAuxBus
reverbLevel
wallOcclusion

ulong AkRoom::GetID ( ) [inline]

Access the room's ID.
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AkRoom

GetID

priority
reverbLevel
wallOcclusion

AK.Wwise.AuxBus AkKkRoom::reverbAuxBus

The reverb auxiliary bus.

| S
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AkRoom

GetlD 'float AKRoom::reverbLevel = 1
priority

reverbAuxBus The reverb control value for the send to the reverb

reverbLevel aux bus.

wallOcclusion | - /
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AkRoom

GetIlD
priority
reverbAuxBus | Occlusion level modeling transmission through
reverbLevel walls.

wallOcclusioniilis 4

rfloat AkRoom::wallOcclusion =1
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AkRoom
int AKRoom::priority = 0

GetlD - _
priority In cases where a game object is in an area with two

rooms, the higher priority room will be chosen for
reverbAuxBus

AK::SpatialAudio::SetGameObjectinRoom() The
reverbLevel higher the priority number, the higher the priority of
wallOcclusion |  a room.
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AkRoomPortal

AkRoomPortal
ClosePortal(GameObject in_gameObject) AkRoomPortal [inline]
GetID() AkRoomPortal [inline]
HandleEvent(GameObiject in_gameObject) AkRoomPortal [inline]
MAX_ROOMS_PER_PORTAL AkRoomPortal
rooms AkRoomPortal
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AkRoomPortal

ClosePortal :
@E ulong AkRoomPortal::GetID ( ) [1

HandleEvent

MAX_ROOMS_PER_PORTAL
rooms

Access the portal's ID.
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AkRoomPortal

ClosePortal - -
override void AkRoomPortal::Han
GetiD

HandleEvent
MAX _ROOMS PER PORTAL
rooms

Opens the portal on trigger event.
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AkRoomPortal

ClosePortal

GetlD void AkRoomPortal::ClosePortal (

HandleEvent
MAX ROOMS PER PORTAL
rooms

Closes the portal on trigger event.
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AkRoomPortal

ClosePortal -
const int AkRoomPortal::MAX RO
GetiD

HandleEvent

MAX ROOMS_PER PORTAL

rooms

AkRoomPortals can only connect a
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AkRoomPortal

ClosePortal AkRoom [] AkRoomPortal::rooms

GetlD
The front and back rooms connected
HandleEvent

side of the portal(opposite to the dire
MAX_ROOMS_PER_PORTAL | | the positive side of the portal.
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AkRoomPortalObstruction

AkRoomPortalObstruction
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AkSpatialAudioEmitter

AkSpatial AudioEmitter
reflectAuxBus AkSpatial AudioEmitter
reflectionMaxPathLength AkSpatial AudioEmitter
reflectionsAuxBusGain AkSpatialAudioEmitter
reflectionsOrder AkSpatial AudioEmitter
roomReverbAuxBusGain AkSpatialAudioEmitter
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AkSpatial AudioEmitter

reflectAuxBus

reflectionMaxPathLength
reflectionsAuxBusGain
reflectionsOrder
roomReverbAuxBusGain

AK.Wwise.AuxBus AkSpatial AudioEm

The Auxiliary Bus with a Reflect plug-in E
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AkSpatial AudioEmitter

reflectAuxBus
reflectionMaxPathLength
reflectionsAuxBusGain

reflectionsOrder

roomReverbAuxBusGain

uint AkSpatialAudioEmitter::reflection

The maximum number of reflections that
processed for a sound path before it reac
listener. Reflection processing grows exp
with the order of reflections, so this numb
be kept low. Valid range: 1-4.
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AkSpatial AudioEmitter

refiec uBus float AkSpatialAudioEmitter::reflectio
reflectionMaxPathLength oa patialAudio *

reflectionsAuxBusGain

reflectionsOrder
roomReverbAuxBusGain

The gain [0, 1] applied to the reflect auxili
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AkSpatial AudioEmitter

reflectAuxBus float AkSpatialAudioEmitter::reflectio

reflectionMaxPathLength

reflectionsAuxBusGain
reflectionsOrder
roomReverbAuxBusGain

A heuristic to stop the computation of refi
longer (and possibly shorter for less CPU
maximum attenuation of the sound emitte
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AkSpatial AudioEmitter

reflectAuxBus
reflectionMaxPathLength

reflectionsAuxBusGain Send gain (0.f-1.f) that is applied when s
reflectionsOrder associated with the room that the emitter

roomReverbAuxBusGain

float AkSpatialAudioEmitter::roomRe
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AkSpatialAudioListener

AkSpatialAudioListener
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AKkState

AkState
grouplD AkState
valuelD AkState
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AkState

int AkState::groupiD

valuelD State Group ID, as defined in WwiselD.cs.

| S
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AkState

int AkState::valuelD

grouplD
State Value ID, as defined in WwiselD.cs.

| S
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AkSurfaceReflector

AkSurfaceReflector

AcousticTexture AkSurfaceReflector
AddGeometrySet(AK.Wwise.AcousticTexture [inli
acousticTexture, MeshFilter meshFilter) AL AREERE

[inli

RemoveGeometrySet(MeshFilter meshFilter) AkSurfaceReflector _; i
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AkSurfaceReflector

static void AkSurfaceReflector::AddGeom

AcousticTexture

Sends the mesh filter's triangles and their aco
RemoveGeometrySet

acoustic Texture

meshFilter
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AkSurfaceReflector

static void AkSurfaceReflector::RemoveG

AcousticTexture Remove the corresponding mesh filter's geo
AddGeometrySet

RemoveGeometrySet

meshFilter
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AkSurfaceReflector

AK.Wwise.AcousticTexture AkSurfaceRefl

AcousticTexture . , :
AddG —— All triangles of the component's mesh will be

eometryse The texture will change the filter parameters o
RemoveGeometrySet  from this component.
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AkSwitch

AkSwitch
grouplID AkSwitch
valuelD AkSwitch

Generated at Thu Feb 1 09:40:31 2018 for Wwise Unity Integration by dﬂ&!ﬂgn 1.6.3


http://www.doxygen.org/index.html

AkSwitch

int AkSwitch::groupID

valuelD Switch Group ID, as defined in WwiselD.cs.

| S
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AkSwitch

int AkSwitch::valuelD

grouplD
Switch Value ID, as defined in WwiselD.cs.

| S
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AkTerminator

AkTerminator
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AKTriggerBase

AkTriggerBase
Trigger(GameObject in_gameObject) AkTriggerBase
triggerDelegate AkTriggerBase
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AkTriggerBase

triggerDelegate

delegate void AkTriggerBase::Trigger ( GameOb

Delegate declaration for all Wwise Triggers.

in_gameObject is used to pas
in_gameObject when Colliders are used. Som
option "Use other object”, this
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AkTriggerBase
Trigger AkTriggerBase::triggerDelegate = null
Trigger

. All components reacting to the trigger will be
WLLERIEEELS | | registered in this delegate.
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AddGeometrySet() : AkSurfaceReflector
AddListener() : AkGameObij

ClosePortal() : AkRoomPortal

ExecuteAction() : AK::Wwise::Event
GetAuxSendValueForPosition() : AKEnvironmentPortal
GetForward() : AkGameODbj

GetlD() : AkRoomPortal , AkKRoom
GetPosition() : AkGameODbj

GetUpward() : AkGameObj

HandleEvent() : AkBank , AkRoomPortal
LoadLocalizedBank() : AkMemBankLoader
LoadNonLocalizedBank() : AkMemBankLoader
Post() : AK::Wwise::Event

PostCallbacks() : AkCallbackManager
PostMIDI() : AK::Wwise::Event
RemoveGeometrySet() : AkSurfaceReflector
RemovelListener() : AkGameObj
SetBGMCallback() : AkCallbackManager
SetMonitoringCallback() : AkCallbackManager
StopMIDI() : AK::Wwise::Event

Trigger() : AKTriggerBase

UnloadBank() : AkBank
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- a -
e AcousticTexture : AkSurfaceReflector

e actionOnEventType : AKEvent
e axis : AKEnvironmentPortal

-b-

e bankName : AkBank , AkMemBankLoader
e basePath : Akinitializer

=-C =

o callbackManagerBufferSize : Aklnitializer
e curvelnterpolation : AKEvent

-d -
e decodeBank : AkBank

o defaultPoolSize : Akinitializer
¢ diffractionFlags : Aklnitializer

- e -
e enableActionOnEvent : AkEvent

e engineLogging : Aklnitializer
e eventlD : AkEvent

-g-



e grouplD : AkState , AkSwitch

.-

-/-

-m

info : AKEventCallbackMsg
iISEnvironmentAware : AkGameObj
isLocalizedBank : AkMemBankLoader

language : Aklnitializer
loadAsynchronous : AkBank
lowerPoolSize : Aklnitializer

m_positionOffsetData : AkGameObj
MAX_ROOMS_PER_PORTAL : AkRoomPortal
maxSoundPropagationDepth : Aklinitializer
memoryCutoffThreshold : AkInitializer
monitorPoolSize : Aklnitializer
monitorQueuePoolSize : Akinitializer

-p-

=F -

preparePoolSize : Akinitializer
priority : AkRoom

reflectAuxBus : AkSpatialAudioEmitter
reflectionMaxPathLength : AkSpatial AudioEmitter
reflectionsAuxBusGain : AkSpatialAudioEmitter
reflectionsOrder : AkSpatialAudioEmitter
reverbAuxBus : AKRoom

reverbLevel : AkRoom

roomReverbAuxBusGain : AkSpatialAudioEmitter
rooms : AkRoomPortal



saveDecodedBank : AkBank
sender : AkEventCallbackMsg
soundEmitterObject : AkEvent
spatialAudioPoolSize : Aklnitializer
streamingPoolSize : Aklnitializer

-t-

e transitionDuration : AKEvent
e triggerDelegate : AkTriggerBase

-u-
e unloadTriggerList : AkBank
-V-
e valuelD : AkState , AkSwitch
-W -

¢ wallOcclusion ;: AkRoom
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